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Preface 

This volume represents the first edition of the teaching material developed for the 

Computer-Aided Graphics and Technical Drawing course, covering the fundamental commands 

of the Part module in SolidWorks, with particular emphasis on the Sketch and Features 

environments. 

The content is organized progressively, ensuring a natural transition from the introductory 

concepts of 2D parametric sketching to the three-dimensional parametric modeling of 

mechanical parts. Each lecture unit provides the necessary theoretical background, while the 

associated laboratory sessions offer the practical context in which the acquired knowledge is 

applied and consolidated. 

Attention has been given to learning outcomes. Each chapter follows a unified didactic 

structure comprising clearly defined learning objectives, theoretical and applied content 

supported by step-by-step demonstrations, exercises proposed for independent completion, and 

review questions. Complementing these, the volume includes a dedicated chapter on practical 

competency assessment, containing representative examination models aligned with the 

requirements of the course. This chapter serves as a concrete preparation and self-assessment 

tool for both instructors and students alike. 

Upon completing this material, the student will have acquired the competencies required 

to create 2D parametric sketches using the Sketch module commands, to generate three-

dimensional parametric models through the Features module commands, and to apply these 

skills effectively in the modeling of mechanical parts of varying geometric complexity. 

 

The Author 
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1. FUNDAMENTALS OF COMPUTER-AIDED GRAPHICS AND 

TECHNICAL REPRESENTATION 

1.1. Chapter Objectives 

This introductory chapter familiarizes the student with the field of computer-aided 

graphics and its role in current engineering practice. It covers the fundamental concepts of 

CAD/CAM/CAE systems, the general structure of the SolidWorks platform, the working 

interface, and the basic principles of parametric modeling, which are necessary for the 

subsequent study of parts, assemblies, and technical drawing. 

1.2. Learning Outcomes 

Upon completion of this chapter, the student will be able to: 

• explain the role of computer-aided design in modern engineering practice;  

• distinguish between the functions of CAD, CAM, and CAE systems;  

• identify the main modules of the SolidWorks platform and their areas of application;  

• recognize the essential elements of the working interface;  

• apply the basic principles of parametric modeling in the creation of simple part models. 

1.3. Theoretical and Applied Content 

1.3.1. The Evolution of Computer-Aided Design 

Before the first computer entered a technical office, engineers worked with drafting tables, 

parallel rulers, and ink pens. Every modification to a drawing meant hours of corrections, and 

reproducing the same part across multiple sheets required considerable manual effort. 

Everything changed in the early 1960s, when Ivan Sutherland, a researcher at the Massachusetts 

Institute of Technology (MIT), developed Sketchpad  the world's first interactive graphical 

application. For the first time, an engineer could draw directly on a computer screen, move, scale, 

and copy geometric shapes with a few simple commands. Although the computers of that era 

occupied entire rooms and carried a prohibitive cost, the seed of a revolution had been planted 

[1]. 

The decades that followed brought gradual but accelerating technological maturation. 

During the 1970s, major industrial companies in the aerospace, automotive, and naval sectors 

began investing in dedicated CAD systems developed by companies such as IBM and Dassault 

Systèmes. These systems were expensive, difficult to operate, and accessible only to large 

corporations. The real turning point came in 1982 with the launch of AutoCAD the first 

computer-aided design program intended for personal computers. A small design office could 

suddenly abandon the drafting table without spending a fortune. The rapid worldwide adoption 
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of AutoCAD demonstrated that CAD technology was no longer the exclusive domain of heavy 

industry but was becoming a standard working tool for every engineer [1]. 

A decisive qualitative leap occurred in the 1990s, when two-dimensional drafting began to 

be replaced by three-dimensional parametric modeling. The emergence of platforms such as 

Pro/Engineer, CATIA, and, in 1995, SolidWorks, fundamentally changed the way engineers 

conceive a product. Rather than drawing separate views  front, lateral, and cross-section  the 

designer now constructs a complete 3D model of the part, and the software automatically 

generates all required views. Any modification to the 3D model is instantly reflected across all 

associated production drawings, eliminating one of the most common sources of error in 

traditional practice. The ability to verify whether two components of an assembly interfere before 

either is manufactured dramatically reduced costs associated with redesign and scrap [2]. 

Today, computer-aided design has far exceeded the boundaries of a simple drafting tool. 

Modern platforms integrate structural and thermal simulations, fluid flow analysis, automatic 

generation of CNC toolpaths, and even generative design algorithms in which the software 

proposes optimized geometries based on constraints defined by the engineer. Cloud-based 

solutions such as Onshape and Fusion 360 have added a further dimension: teams distributed 

across multiple continents can work simultaneously on the same model without exchanging files 

by email. In the context of Industry 4.0, where digital and physical production are increasingly 

intertwined, proficiency in CAD tools is no longer an optional advantage but a baseline 

requirement for any engineer seeking to remain competitive in the labor market [3]. 

 

1.3.2. General Concepts of CAD/CAM/CAE Systems 

CAM, and CAE systems represent the three fundamental components of modern 

computer-aided design and manufacturing. CAD (Computer-Aided Design) is the tool through 

which the engineer defines a product geometrically: shape, dimensions, tolerances, and 

materials. Unlike classical technical drawing, the CAD model is a precise mathematical 

representation from which production drawings, bills of materials, and technical documentation 

are automatically derived. Any modification propagates instantly across all associated 

documents, eliminating redundancy and transcription errors. 

CAM (Computer-Aided Manufacturing) takes the geometric model and automatically 

generates programs for CNC machine tools, including tool paths, cutting speeds, and the 

sequence of operations. Information flows directly from design to manufacturing without 

manual re-entry, significantly reducing production setup time and the risk of error. 

CAE (Computer-Aided Engineering) functions as a virtual laboratory in which the digital 

model is subjected to structural, thermal, and fluid simulations before any physical prototype is 

built. Finite Element Analysis (FEA) and Computational Fluid Dynamics (CFD) allow the 

identification and correction of design weaknesses during the design phase itself, reducing the 

costs and time associated with subsequent redesigns. 
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The three systems do not operate in isolation but form an integrated workflow known as 

PLM (Product Lifecycle Management). The SolidWorks platform reflects this philosophy 

through its Part, Assembly, Simulation, and Drawing modules, which coexist within the same 

environment and exchange data in real time, providing the engineer with a complete ecosystem 

from initial concept to final documentation [8]. 

1.3.3. General Overview of the SolidWorks Platform 

SolidWorks is a computer-aided design (CAD) software developed by Dassault Systèmes, 

released in 1995 and intended for three-dimensional parametric modeling. Unlike the CAD 

solutions of that era, SolidWorks was designed to run on personal computers with the Windows 

operating system, which significantly reduced the cost of accessing 3D technology for design 

offices of any size. 

The platform provides an integrated working environment that covers the entire product 

development workflow: from the initial sketch and individual part modeling, through 

component assembly and structural analysis, to the generation of technical documentation. All 

these stages take place within the same software environment, without the need to export data 

between different applications, ensuring information consistency throughout the entire project. 

Over three decades of continuous development, SolidWorks has become one of the most 

widely used CAD programs worldwide, with applications spanning the automotive, aerospace, 

and medical industries, as well as higher technical education. The combination of advanced 

functionality, a large user community, and extensive documentation establishes it as a reference 

tool for developing computer-aided design competencies. 

1.3.4. Main Modules of the SolidWorks Platform 

1.3.4.1. The Part Module 

The Part module (Figure 1.1) represents the starting point of any modeling process carried 

out in SolidWorks and constitutes the foundation upon which all subsequent stages of the design 

are built. Within this module, the user creates individual three-dimensional parts, starting from 

a two-dimensional sketch drawn on one of the reference planes of the working space and 

progressively transforming it into a fully defined geometric solid. 

The modeling process follows a sequential and intuitive logic. The basic geometry of the 

part is first established through volume-generating operations, of which the most frequently 

used are extrusion (Extruded Boss/Base), which projects a planar sketch to a specified depth, and 

revolution (Revolved Boss/Base), which rotates a profile around an axis to produce shaft, flange, 

or ring geometries. For more complex geometries, the module provides operations such as 

Sweep, through which a profile is guided along a curved path, and Loft, which interpolates 

between two or more distinct cross-sections. 
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Figure 1.1 Parametric Modeling in the Part Module 

Once the base volume is obtained, the model is refined through editing operations: edge 

rounding with fillet radii (Fillet), chamfering (Chamfer), wall thinning for shell-type parts (Shell), 

and the duplication of geometric elements according to a linear or circular pattern (Pattern). 

Internal and external threads may be represented cosmetically or modeled geometrically, 

depending on project requirements. 

A fundamental aspect of the Part module is the parametric nature of the resulting models. 

Every dimension entered can be modified at any point, and the entire geometry updates 

automatically as a consequence. This property is particularly valuable in automotive part design, 

where the same component may exist in different dimensional variants for distinct vehicle 

models, without requiring the modeling process to be restarted from scratch. The operation 

history, visible in the FeatureManager Design Tree, provides complete traceability of all 

construction stages and allows the user to return to and modify any previous operation. 

1.3.4.2.  The Assembly Module 

The Assembly module (Figure 1.2) represents the natural stage that follows the modeling 

of individual parts, in which separate components acquire meaning through their relationships 

with one another. While the Part module focuses the engineer's attention on the geometry of a 

single part, Assembly shifts the focus to how parts interact, support each other, and together 

form a coherent functional system. 

Component assembly is achieved through geometric constraints known as Mates, which 

define the spatial relationships between parts: two surfaces may be declared coincident, two axes 
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concentric, two faces parallel, or separated by a precise distance. By progressively applying these 

constraints, each component loses its degrees of freedom until its position within the assembly 

is fully determined. This approach faithfully reflects the logic of physical assembly in a workshop 

and helps the student understand, prior to any hands-on experience, why a flange requires 

centering, why a bearing must be concentric with the shaft, or why a gasket requires planar 

contact with both adjacent surfaces. 

 

 
Figure 1.2 Assembly Example in SolidWorks 

 

A major advantage of the Assembly module is its ability to automatically detect 

interferences between components. In the automotive industry, where hundreds of parts coexist 

within extremely confined spaces, digital interference checking prior to manufacturing 

eliminates costly errors that would otherwise only be discovered at the physical prototype stage. 

SolidWorks identifies and visually highlights any common volume between two parts that could 

not occupy the same space. 

The module also allows the simulation of motion in assembled mechanisms. It is thus 

possible to animate a connecting rod and crank mechanism, verify the stroke of a piston, or 

observe the relative motion of a suspension system, gaining an understanding of the kinematic 

behavior of the assembly before it is physically built. This capability transforms the 3D model 

from a simple volumetric drawing into an analysis and validation tool for the design solution. 

1.3.4.3.  The Drawing Module 

The Drawing module (Figure 1.3) is the stage at which the previously created three-

dimensional model becomes an official technical document, suitable for use in manufacturing, 
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inspection, and assembly. While the earlier modules deal with building the part in virtual space, 

Drawing deals with communicating that part to those who will physically manufacture or 

assemble it. 

Drawings generated in SolidWorks are directly linked to the 3D model, meaning that any 

modification made to the part is automatically reflected in the drawing as well. This connection 

eliminates one of the most common errors in classical design practice, namely the situation in 

which the drawing and the model no longer correspond after several rounds of revisions. 

The placement of views on the sheet, the addition of dimensions, and the creation of cross-

sections are performed quickly and intuitively, in compliance with applicable technical 

standards. Beyond geometry, the module allows the addition of dimensional tolerances, surface 

roughness indications, and other specifications required for the correct manufacture of the part. 

Working with the Drawing module develops two complementary skills. The first is the 

ability to produce a correct and complete technical drawing. The second is the ability to read and 

interpret technical drawings received from colleagues, suppliers, or industrial partners. In the 

day-to-day practice of the automotive industry, both prove equally important and are used 

routinely in every design office. 

 

 
 

Figure 1.3 Technical Drawing Example in SolidWorks 

1.3.4.4. The Sheet Metal  Module 

The design of sheet metal components occupies a central role in the automotive industry, 

and the Sheet Metal module, presented in Figure 1.4, provides the tools required to address this 

specific category of parts. Body panels, brackets, housings, heat shields, and numerous other 
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structural and functional vehicle components are produced through cold plastic deformation, 

and this module faithfully reflects the technological logic of these processes. 

Unlike standard modeling in the Part module, Sheet Metal operates according to material-

specific logic: the material thickness remains constant throughout the entire part, and the 

available operations correspond directly to real manufacturing processes. Bends are defined with 

precise radii of curvature and angles, cutouts are applied to the flat surfaces of the part, and 

corners are managed automatically to prevent material overlaps that would render the part 

unmanufacturable. 

One of the most useful features of the module is the automatic flat pattern generation. Any 

component modeled in Sheet Metal can be unfolded with a single command, producing the flat 

blank geometry with the actual dimensions of the semi-finished part and the bend line markings. 

This flat pattern can be exported directly for laser cutting or stamping, eliminating manual 

calculations and reducing the risk of error in manufacturing preparation. 

The relationship between the three-dimensional geometry of the part and its flat pattern is 

maintained permanently and bidirectionally. Any modification to the 3D geometry 

automatically updates the flat pattern and vice versa, making Sheet Metal a valuable tool both in 

design and in the analysis of existing parts, when the objective is to understand the original flat 

geometry of an already manufactured component. 

 

 
 

Figure 1.4 Sheet Metal Part Example in SolidWorks 
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1.3.4.5. The Weldments Module 

Welded structures are an essential component of mechanical engineering and are present 

in virtually every industrial sector, from body frames and powertrain support structures to 

chassis sub-assemblies and working platforms for special-purpose vehicles. The Weldments 

module in SolidWorks (Figure 1.5) is specifically designed for the design of such structures, 

offering a workflow adapted to the constructive logic of welded fabrication. 

The working principle of the module starts from a three-dimensional sketch of the 

structure, representing the axes of the constituent elements. Standardized structural profiles — 

such as rectangular tubes, L, U, and I sections — are automatically applied along each segment 

of this sketch, instantly generating the complete three-dimensional structure. The profile library 

covers the most common industry standards and can be extended with custom profiles tailored 

to the specific requirements of a given project. 

At element intersections, the module automatically manages the joints, calculating and 

applying the end cuts required for profiles to meet correctly without material overlaps. Once the 

structure is complete, SolidWorks automatically generates the cut list with the exact lengths of 

each element, information that can be used directly in manufacturing preparation. 

 

 
 

Figure 1.5 Welded Structure Example in SolidWorks 
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1.3.4.6. The  Simulation Module 

One of the fundamental challenges of product engineering is validating the behavior of a 

component before it is manufactured and subjected to physical testing. The answer to this 

challenge, traditionally provided only through prototyping and experimental testing, can today 

be obtained far more rapidly and economically through numerical simulation. The Simulation 

module in SolidWorks (Figure 1.6) provides precisely these tools, transforming the existing 3D 

model into a virtual testing environment. 

Structural analysis using the Finite Element Method (FEA) is the central functionality of the 

module. By applying forces, pressures, or moments to the surfaces of the part and defining the 

support conditions, the software calculates the distribution of stresses and deformations 

throughout the entire volume of the component. Regions subject to excessive loading are visually 

highlighted through a color map, directing the designer toward the constructive modifications 

necessary to improve the mechanical performance of the part. 

Beyond structural analysis, the module covers other types of loading conditions frequently 

encountered in the automotive industry. Thermal analysis allows the study of temperature 

distribution and heat flux in components exposed to thermal sources, such as parts in the vicinity 

of the engine or exhaust system. Fatigue analysis estimates the service life of a part subjected to 

cyclic loading, which is particularly relevant for suspension and transmission components. Fluid 

flow simulation, available through the complementary Flow Simulation module, extends this 

analysis environment to include the study of aerodynamic behavior and cooling system 

performance. 

The practical value of the Simulation module lies in reducing the number of physical 

prototypes required during product development. Each design iteration can be numerically 

validated before being sent to manufacturing, shortening the development cycle and reducing 

the costs associated with late-stage redesigns. 
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Figure 1.6 Simulation Example in SolidWorks 

1.3.4.7. The  Electrical Module 

In the modern automotive industry, the complexity of electrical and electronic systems has 

grown exponentially over recent decades. A contemporary automobile contains kilometers of 

wiring, hundreds of connectors, and dozens of electronic control units, and managing this 

complexity within the same design environment as the mechanical components has become an 

increasingly pressing practical requirement. The Electrical module in SolidWorks (Figure 1.7) 

addresses precisely this need, providing dedicated tools for the design and integration of 

electrical systems directly within the 3D product model. 

The workflow of the module covers the entire electrical design process, from the schematic 

diagram through to the physical routing of wiring harnesses within the three-dimensional space 

of the assembly. Wires, cables, and harness bundles are defined with their actual properties — 

cross-sectional area, conductor material, insulation type, and color — and are routed through the 

available space of the product, respecting minimum bend radii and avoiding interferences with 

surrounding mechanical components. 

A significant advantage of integrating electrical design within the 3D CAD environment is 

the ability to verify in real time the compatibility between wiring routes and the mechanical 

geometry of the product. Modifications made to the mechanical structure are immediately 

reflected in the electrical routes, alerting the designer to potential conflicts before they become 

manufacturing issues. At the conclusion of the design process, the module automatically 

generates the documentation required for harness manufacturing, including wire lists, connector 
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tables, and wiring diagrams, significantly reducing the time allocated to technical 

documentation. 

 

 
Figure 1.7 Electrical Schematic Module in SolidWorks 

1.3.4.8. The Plastics Module 

Plastic materials occupy an increasingly important role in the construction of modern 

vehicles, being present in components such as instrument panels, headlamp housings, body 

panels, interior brackets, and numerous other functional and aesthetic parts. The design of these 

components presents a specific challenge: the final geometry of the part is determined not only 

by functional requirements but also by the behavior of the molten plastic material during the 

injection molding process. The Plastics module in SolidWorks (Figure 1.8) addresses precisely 

this challenge, numerically simulating the entire injection molding process before the mold is 

manufactured. 
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Figure 1.8 Plastic Injection Simulation Example in SolidWorks 

The simulation covers the essential phases of the injection process: filling the mold cavity 

with molten plastic material, compacting the material under pressure, and progressive cooling 

through to solidification. Throughout these phases, the module calculates and visualizes the 

distribution of temperature, pressure, and material flow velocity, identifying regions where 

typical defects may occur, such as weld lines, sink marks, warping, or incomplete cavity fill. 

The information obtained from the simulation allows the designer to optimize both the part 

geometry and the process parameters — including gate location, mold temperature, and pressure 

profile — prior to any investment in the manufacture of the physical mold. In the automotive 

industry, where injection molds for large components can represent investments in the range of 

tens or hundreds of thousands of euros, prior numerical validation through the Plastics module 

significantly reduces the financial risk associated with a non-optimized design and shortens the 

time to launch a new product on the production line. 

1.3.5. The SolidWorks Working Environment 

First contact with the SolidWorks interface may seem overwhelming, but its organization 

follows a clear and consistent logic that becomes familiar after the first few hours of use. The 

working environment is structured into distinct zones, each with a well-defined role in the design 

process, so that all necessary tools are quickly accessible without interrupting the workflow. 
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At the core of SolidWorks lies the principle of parametric modeling. Every dimension, 

every geometric relation, and every operation applied to a model is stored and remains editable 

throughout the entire design process. This means that a modification applied to a base parameter 

propagates automatically through all geometry dependent on it, eliminating the need to 

manually rework affected elements and significantly reducing the risk of error during design 

iterations. 

 

 
Figure 1.9 The SolidWorks Interface 

The main interface, presented in Figure 1.9, is composed of several functional zones that 

work together. The menu bar provides access to all program commands, organized into logical 

categories such as File, Edit, View, Insert, and Tools. The main toolbar groups the most 

frequently used commands, automatically adapting to the active module — in the Part module, 

modeling tools are displayed, while in the Drawing module, dimensioning and annotation tools 

appear. 

On the left side of the screen is the Activity Manager, also known as the FeatureManager 

Design Tree, highlighted in Figure 1.9. It displays the complete history of operations applied to 

the model in a tree structure that allows access to and editing of any previous operation. The 

coordinate triad in the workspace indicates the orientation of the coordinate system, providing 

a permanent visual reference of the model's position in three-dimensional space. The status bar, 

located at the bottom of the screen, displays contextual information about the current state of the 

model, the active units of measurement, and guidance messages useful during command 

execution. On the right side of the screen, the SolidWorks Resources Panel provides quick access 

to tutorials, documentation, and installation diagnostics tools. 
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1.3.5.1. The Menu Bar and Toolbars 

The menu bar provides access to all program functions and is organized into clearly defined 

categories. The File menu manages document-related operations: creating, opening, saving, and 

exporting files. The Edit menu contains standard editing commands, such as undoing operations 

and selecting entities. The View menu controls the display mode of the model, the Insert menu 

is used for adding new operations and reference elements, and the Tools menu provides access 

to analysis tools and the general settings of the application (Figure 1.10). 

 

 
Figure 1.10 The Menu Bar in SolidWorks 

 

The main toolbar groups quick-access commands for file management, operation history 

navigation, and display control, and remains permanently visible regardless of the active 

module. 

Below it sits the contextual toolbar, whose content automatically adapts according to the 

current working module. It is organized into tabs that can be activated with a simple click on 

their name. The main available tabs are as follows. The Sketch tab contains the tools for creating 

and editing two-dimensional sketches. The Features tab groups the commands for generating 

three-dimensional elements, such as extrusion, revolution, cut operations, and fillet operations. 

The Sheet Metal tab provides the tools specific to sheet metal component design, while the 

Weldments tab is dedicated to welded structures. The Evaluate tab provides tools for model 

verification and analysis. 

The tabs visible in the toolbar depend on the type of document open and the modules 

installed. They can be customized by accessing the Tools menu, then Customize, where the user 

can activate or deactivate additional tabs, add new commands to existing toolbars, or create 

custom toolbars adapted to their specific workflow. This flexibility allows the configuration of 

an efficient working environment in which the most frequently used commands are always 

readily accessible (Figure 1.11). 

 

 
Figure 1.11 The Main Toolbar in SolidWorks 
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1.3.5.2. The FeatureManager Design Tree 

The Activity Manager, located on the left side of the interface, provides an efficient means 

of organizing and navigating between the components of the project. It includes the history of 

completed operations, the assembly structure, and details about the properties of the model 

(Figure 1.12).  

 

 
Figure 1.12 The Activity Manager in SolidWorks 

1.3.5.3. The Graphics Area and Spatial Orientation 

The graphics area represents the central space of the SolidWorks interface, the place where 

the model actually takes shape. Two-dimensional sketches are created here, three-dimensional 

parts are constructed, and components are assembled into complex assemblies. All modeling 

activity takes place within this space, and the quality of visualization and ease of navigation 

directly influence the efficiency of the design process. 

A permanently present reference element in the graphics area is the coordinate triad, which 

indicates the orientation of the X, Y, and Z axis system relative to the current model (Figure 1.13). 

The Z axis, represented in blue, indicates the vertical direction of the workspace. The Y axis, 

represented in green, corresponds to the depth direction, while the X axis, represented in red, 

indicates the horizontal direction. This triad provides a permanent and essential visual reference, 

particularly when the model is rotated and the viewing perspective changes frequently during 

work. 

 

 
Figure 1.13 The Coordinate Triad in SolidWorks 

 

Navigation in three-dimensional space is performed through the visualization commands 

grouped in the navigation bar of the graphics area (Figure 1.14). Each command in this bar has a 

specific and well-defined role in the interaction with the model. 
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Figure 1.14 The Graphics Area Navigation Bar in SolidWorks 

 

Zoom to Fit automatically adjusts the zoom level so that the entire model is visible in the 

graphics area, regardless of its position or size. It is particularly useful after operations that 

significantly alter the dimensions of the model or after navigation in which the model has 

partially moved out of the field of view. Zoom to Area allows the manual definition of a 

rectangular region on the screen to which the zoom is applied, providing precise control over the 

portion of the model to be examined in detail. Zoom In/Out performs progressive approach or 

withdrawal from the model and is most quickly accessed by scrolling the mouse wheel. 

Rotate View allows the free rotation of the model around any axis, enabling the 

examination of the geometry from any angle. In practice, this is most efficiently activated by 

pressing and holding the middle mouse button while moving the cursor in the desired direction. 

Pan translates the model within the plane of the screen without modifying the viewing angle or 

zoom level, and is useful for recentering the model in the graphics area without losing the current 

perspective. It is activated through the combination of the Ctrl key and the middle mouse button. 

Section View generates a cross-sectional view of the model along a user-defined plane, 

allowing the examination of internal geometry without modifying the model itself. It is 

particularly useful for verifying wall thicknesses, internal bores, or the relative position of 

components within an assembly. View Orientation provides quick access to standard model 

orientations, such as front, back, lateral, top, and isometric views, allowing rapid repositioning 

of the viewing perspective with a single click. Display Style controls the visual representation 

mode of the model, offering options such as shaded display with materials, display with visible 

edges, wireframe display, and transparent display, each being useful in different contexts 

throughout the design process. 

Mastering these navigation and visualization commands is one of the first practical skills 

to be consolidated when working with SolidWorks, as the ability to examine the model quickly 

and efficiently from any perspective directly conditions the quality and speed of the entire 

modeling process. 

1.3.5.4. The Status Bar 

The status bar, visible at the bottom of the SolidWorks interface (Figure 1.15), is a discreet 

yet extremely useful element in day-to-day design work. Although it occupies little screen space, 

the information it displays provides a constant and clear picture of the state of the active 

document and the current working context. 
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Figure 1.15  The Status Bar in SolidWorks 

 

On the left side of the status bar are the navigation tabs between the available visualization 

types for the current document. The Model tab displays the three-dimensional model in the 

graphical workspace and represents the primary visualization used during the modeling 

process. The 3D Views tab provides access to predefined or user-saved three-dimensional 

perspectives, useful for presenting and documenting the model. The Motion Study tab is 

dedicated to motion and animation studies, allowing the simulation of the kinematic behavior of 

assembled mechanisms. 

In the central area of the status bar, the active working context is displayed. The Editing 

Part indication signals that the user is in part editing mode, which is particularly relevant when 

working within an assembly and editing an individual component from within it. 

On the right side of the status bar, the active units of measurement of the current document 

are displayed. SolidWorks provides four predefined unit systems: MKS (meter, kilogram, 

second), used in large-scale engineering applications and applied physics calculations; CGS 

(centimeter, gram, second), specific to scientific fields and less commonly encountered in 

industrial mechanical design; IPS (inch, pound, second), standard in the American industry and 

in design according to ANSI standards; and MMGS (millimeter, gram, second), the 

recommended system for European mechanical engineering work. 

Warning or error messages relating to incomplete operations, unsatisfied constraints, or 

geometric conflicts may also appear in this area, directing the user quickly to the source of the 

problem without the need for a manual search through the operation history. 

1.3.5.5. The SolidWorks Resources Panel 

The SolidWorks Resources Panel is located on the right side of the interface and represents 

the centralized access point for support tools, documentation, and services associated with the 

platform. Although it is often overlooked in the early stages of learning, this panel becomes a 

valuable resource as project complexity increases and situations arise that require additional 

documentation or problem diagnosis (Figure 1.16). 
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Figure 1.16 The SolidWorks Resources Panel 

The SOLIDWORKS Tools section groups a series of utilities dedicated to the configuration 

and optimization of the working environment. Property Tab Builder allows the creation of 

custom forms for entering document properties, useful for managing part and assembly 

metadata within a large-scale project. SOLIDWORKS Rx is an installation diagnostics tool that 

checks hardware compatibility, identifies potential driver conflicts, and provides 

recommendations for optimizing the graphical performance of the application. Performance 

Benchmark Test evaluates the performance of the computer against SolidWorks requirements, 

providing a clear picture of the system's capacity to handle high-complexity models. 

The Online Resources section connects the user directly to the digital ecosystem of the 

platform. Access to the 3DEXPERIENCE Marketplace is available here  the collaboration and 3D 

model exchange platform developed by Dassault Systèmes  along with access to the network of 

partners and complementary solution providers. 

 

 
Figure 1.17 The Design Library and Appearance/Materials Panel in SolidWorks 
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The integrated tutorials, also accessible from this panel, represent a valuable starting point 

for consolidating knowledge of the platform's commands and workflows. They cover both basic 

operations and advanced functionality, are structured progressively, and are accompanied by 

practice models. Before beginning any modeling session, it is essential to correctly configure the 

units of measurement in Document Properties and to save the file initially in an organized 

directory  simple practices that prevent data loss and ensure document consistency throughout 

the entire project. 

1.3.6. Fundamental Principles of Parametric Modeling 

Parametric modeling represents the central philosophy upon which SolidWorks is built and 

which fundamentally distinguishes it from a simple three-dimensional drawing program. In a 

parametric model, geometry is not defined by fixed coordinates but by parameters and relations, 

meaning that the shape of the part is governed by rules rather than rigid values. This approach 

gives models remarkable flexibility: modifying a single parameter can automatically update 

dozens of dependent geometric elements without any additional manual intervention. 

1.3.6.1. 2D Sketching and Geometric Relations 

Every three-dimensional model created in SolidWorks starts from a two-dimensional 

sketch. The sketch is the basic profile of the part, drawn on a reference plane or on a flat face of 

an existing solid, and represents the geometry that will subsequently be extruded, revolved, or 

guided to generate the desired three-dimensional volume. 

Creating a sketch begins with the selection of the working plane, which can be one of the 

three standard planes of space — Front Plane, Top Plane, or Right Plane — or any flat face of 

the existing model. After activating Sketch mode, the user has a series of drawing tools available: 

Line for straight segments, Circle for circles, Rectangle for rectangles, Arc for circular arcs, and 

Spline for free-form curves. These tools allow the rapid definition of any planar geometry, from 

simple profiles to complex contours with dozens of entities. Centerline is used in sketch mode 

to trace construction lines that do not form part of the actual geometry of the part but serve as 

auxiliary references. These are represented graphically as dashed lines and are ignored during 

extrusion or any other modeling operation. The primary uses of the Centerline command are the 

definition of axes of symmetry for applying the Symmetric relation, the tracing of the axis of 

rotation for the Revolved Boss/Base operation, and the creation of dimensioning references for 

diameters and angular positions. A construction line can also be obtained by converting an 

ordinary line, by checking the For Construction option in its PropertyManager. 
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A fundamental aspect of parametric sketching is the use of geometric constraints, which 

define the relationships between drawn entities independently of their numerical dimensions. A 

Coincident constraint requires two points to occupy the same position in space. Parallel keeps 

two lines permanently parallel regardless of subsequent modifications to the sketch. 

Perpendicular guarantees a right angle between two entities, Tangent ensures tangential 

continuity between a line and an arc, and Concentric keeps two circles or arcs on the same center. 

These relations are applied automatically by the program when the drawn geometry suggests 

such an intent, or they can be added manually by the user by selecting the desired entities. A 

fully defined sketch, in which all entities are governed either by geometric constraints or by 

dimensions, is represented by black lines and constitutes the basis of a robust and predictable 

parametric model. 

1.3.6.2. Sketch Dimensioning 

While geometric relations define the shape and relative position of entities within a sketch, 

dimensional dimensioning is what assigns them precise numerical values. In SolidWorks, 

dimensioning is performed through the Smart Dimension command, an intelligent tool that 

automatically recognizes the type of selected entity and proposes the corresponding dimension. 

Applied to a line segment, it generates a length dimension. Applied to a circle, it offers the option 

of dimensioning the diameter or the radius. Applied between two parallel lines, it measures the 

distance between them, and applied between two intersecting lines, it measures the angle 

between them. 

 

 
 

Entered dimensions are not mere decorative labels but active parameters that govern the 

geometry of the sketch. Modifying the value of a dimension causes the immediate update of the 

associated geometry, preserving all previously defined relations and constraints. This property 

is essential in the iterative design process, in which the dimensions of a part are progressively 

adjusted as the design solution is refined. 
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1.3.6.3.   Basic Operations: Extrude and Revolve 

Extrusion and revolution are the most fundamental volume-generating operations in 

SolidWorks and constitute the starting point for modeling the majority of mechanical parts. A 

thorough understanding of these two operations and their operating logic is essential, as they 

appear in virtually every modeling sequence regardless of the complexity of the final part. 

Extrude is the operation by which a two-dimensional sketch is projected in a direction 

perpendicular to its plane, generating a solid volume by adding the third dimension. The 

extrusion distance, referred to as depth, is entered numerically and can be applied in a single 

direction from the sketch plane or in both directions simultaneously through the Mid Plane 

option, which distributes the depth equally on either side of the profile. The termination 

condition of the extrusion can be defined in several ways: at a fixed distance through the Blind 

option, up to a selected surface through the Up to Surface option, or through the entire model 

through the Through All option. The Extrude Cut command uses the same mechanism but 

removes material rather than adding it, serving as the digital equivalent of a milling or drilling 

operation in a machining workshop. 

Revolve generates volumes of revolution by rotating a two-dimensional profile around an 

axis of symmetry. The axis can be a line included in the sketch, traced as a construction line, or 

an edge of the existing model. The angle of rotation defaults to 360 degrees, generating a 

complete solid of revolution, but can be reduced to obtain partial sectors. This operation is the 

natural tool for modeling parts with axial symmetry, a category extremely common in 

manufacturing: transmission shafts, wheel spindles, pistons, valves, bearing rings, and 

numerous other powertrain and braking system components are routinely generated through 

Revolve operations. Similarly, the Revolve Cut command uses the same principle for material 

removal, allowing the creation of circular grooves or internal relief features. 

1.3.6.4.   Generation Operations: Sweep and Loft 

Sweep and Loft are advanced modeling operations used when the geometry of a part 

exceeds the capabilities of the basic Extrude and Revolve operations. Both allow the generation 

of complex three-dimensional forms with variable cross-sections or curvilinear paths, and are 

frequently encountered in the design of geometrically elaborate components in the automotive 

industry. 

Sweep generates a three-dimensional volume by guiding a two-dimensional profile along 

a defined path. Unlike Extrude, which projects the profile in a straight and fixed direction, Sweep 

follows any path, whether straight, two-dimensional curvilinear, or three-dimensional. The 

operation requires two mandatory elements: the profile, which defines the cross-section of the 

generated volume, and the path, which defines the trajectory the profile follows through space. 

Applications of this operation are numerous in the automotive field: exhaust system pipes, 

cooling hoses, wiring harnesses, bumpers, and door sealing profiles are typical examples of parts 
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generated through Sweep operations. The Sweep Cut command uses the same principle for 

material removal, allowing the creation of helical channels or splines with complex paths. 

Loft generates a three-dimensional volume by interpolating between two or more two-

dimensional profiles located on different planes. While Sweep maintains the same profile 

throughout the entire path, Loft allows the progressive modification of the cross-sectional shape 

from one profile to another, resulting in forms with geometry that varies along their length. The 

profiles can be of different shapes — a rectangle at one end and a circle at the other, for example 

— and SolidWorks automatically calculates and generates the transition between them. For more 

precise control over the generated shape, guide curves can be added to constrain the manner in 

which the interpolation is carried out between profiles. In the automotive industry, the Loft 

operation is used in the modeling of aerodynamic elements, fluid body panels, and engine intake 

components, where the cross-section varies continuously to optimize fluid flow. 

Both Sweep and Loft can be used in either the material-adding or material-removing 

variant, providing complete flexibility in the construction or machining of any complex 

geometry. 

1.3.6.5.   Editing Commands 

Editing operations represent the set of tools applied to an already generated solid with the 

purpose of refining, optimizing, or transforming the existing geometry. They cover a wide range 

of interventions, from simple edge rounding to complex deformation or geometry duplication 

operations. 

Fillet rounds the edges of a solid by replacing them with curved surfaces of a specified 

radius. The radius can be constant, variable, or defined by a control curve, and the operation can 

be applied simultaneously to multiple edges. Beyond its aesthetic role, filleting reduces stress 

concentrations and improves the mechanical behavior of the part in service. 

Chamfer creates chamfers at selected edges, replacing the sharp edge with a flat surface 

defined by a distance and an angle or by two distances. It is frequently used at shaft ends, thread 

entries, and on parts intended for automated assembly, where it facilitates the insertion and 

alignment of components. 

Shell transforms a solid body into a thin-walled shell of uniform thickness by removing the 

interior material and retaining an outer envelope of specified thickness. Selected faces are 

removed, creating the necessary openings. The operation is essential in the design of housings, 

covers, and any shell-type components. 

Draft applies a taper angle to the vertical faces of a solid relative to a reference direction 

known as the pull direction. This operation is mandatory for parts produced by casting or 

injection molding, as an insufficient draft angle makes it impossible to extract the part from the 

mold cavity without damaging the surfaces. 
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Rib generates stiffening ribs from an open sketch traced on a reference plane. Ribs are thin 

structural elements that reinforce part walls without adding significant mass, and are frequently 

used in the design of plastic parts or cast metal housings. 

Pattern duplicates a geometric element according to a defined pattern. Linear Pattern 

distributes entities along one or two linear directions, Circular Pattern arranges them around an 

axis at equal angular intervals, and Curve Driven Pattern distributes them along an arbitrary 

curve. Fill Pattern automatically fills a surface with instances of the selected element, distributed 

uniformly according to a chosen geometric pattern such as diamonds, polygons, or squares. 

Mirror creates a symmetrical copy of one or more operations relative to a selected plane of 

symmetry. It is used whenever the part exhibits symmetry about a plane, eliminating the need 

to repeat operations on the opposite side of the model and ensuring perfect geometric symmetry. 

Wrap projects a two-dimensional sketch onto a curved surface of the model, either by 

engraving or by adding material. It is used for inscribing text or symbols on cylindrical or conical 

surfaces, such as markings on shafts or embossed labels on plastic housings. 

Dome deforms a flat or curved face of the model, creating a spherical or ellipsoidal 

protrusion of specified height. It is used in the design of covers, tanks, or components that require 

domed shapes for additional rigidity or aesthetic purposes. 

Indent creates an imprint of one component in the surface of another, useful in the design 

of gaskets, sealing parts, or any situation in which two surfaces must conform precisely to one 

another. 

Flex globally deforms a solid model through bending, twisting, tapering, or stretching 

operations, applicable to the entire body or to a selected portion. It is used for rapidly adjusting 

the overall shape of a part without modifying the underlying sketches and base operations. 

Scale modifies the overall dimensions of a model by a uniform scaling factor or by 

differentiated factors along each axis. It is frequently used in mold design, where the cavity 

dimensions must be larger than the final part to compensate for material shrinkage upon cooling. 

Intersect generates a new solid from the common volume of two or more overlapping 

bodies, or performs complex Boolean operations between multiple bodies. It is useful in the 

design of parts whose shapes are defined by the intersection of simpler geometries. 

Split divides a solid into two or more distinct bodies using a separating plane or surface. It 

is used in the design of multi-segment parts or in preparing models for analysis on separate 

components. 

Move/Copy Body translates or copies a solid body within the same document through 

translation, rotation, or by defining constraints relative to existing geometry. It is useful in 

managing multi-body models and in rapidly creating positional variants of the same element. 

Delete Body permanently removes a solid body from the document, useful for cleaning up 

intermediate bodies that served as references or tools in the construction of the final geometry 

but do not form part of the finished part. 
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1.3.7. Additional Learning Resources 

Mastering design software such as SolidWorks is a continuous process that does not end 

once the basic concepts have been covered. The complexity of the platform and the diversity of 

its application domains constantly require the discovery of new techniques, the optimization of 

workflows, and the resolution of domain-specific problems. Fortunately, the resource ecosystem 

available around SolidWorks is one of the richest in the CAD industry. 

The first point of reference is the tutorials integrated directly into the application, accessible 

through the Help menu. These cover the fundamental operations of each module, from the first 

sketch to the generation of a complete technical drawing, and are structured progressively, 

guiding the user step by step through each command. The advantage of these tutorials is that 

they are synchronized with the installed version of the program and accurately reflect the 

interface and options available in the current working environment. 

The official SolidWorks documentation, available both within the application and online at 

help.solidworks.com, represents the complete technical reference for the platform. Every 

command, every option, and every parameter is described in detail, accompanied by illustrated 

examples and notes on version compatibility. Consulting the official documentation is the 

recommended practice whenever the behavior of a command is not fully understood or when 

exploring the advanced options of a given feature. 

The global SolidWorks user community represents a resource of exceptional practical 

value. The official MySolidWorks forum, user groups, and dedicated platforms such as the 

SolidWorks Forum bring together professionals and enthusiasts from around the world, who 

share solutions to concrete problems, modeling techniques, practice files, and tips from industrial 

practice. A modeling problem that appears unsolvable frequently finds a detailed answer within 

these communities, posted by someone who has encountered a similar situation. Dedicated 

channels on platforms such as YouTube complement this offering with video demonstrations of 

modeling techniques, freely accessible and organized by difficulty level. 
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1.3.8. Practical Application 

1.3.8.1. Modeling a Three-Dimensional Rectangular Block 

By following these steps, a beginner user will be able to model a simple three-dimensional 

body (rectangular block) using basic commands such as Rectangle, Smart Dimension, and 

Extruded Boss/Base. The process introduces essential concepts such as sketching on 2D planes, 

adding dimensions, and transforming a planar profile into a 3D model. 

 

1. Creating a New Document 

To initiate the modeling process, the SolidWorks application is launched and the File → 

New option is selected from the main menu, or the keyboard shortcut Ctrl + N is used. From the 

New Document window, the Part file type is selected, which is used for modeling individual 

parts. The selection is confirmed by clicking the OK button, opening the working interface. 

 

 
 

2. Accessing the Sketch Module 

The next step involves activating the Sketch module. This is done by selecting the Sketch 

tab from the main toolbar. The user then selects one of the available planes — Front Plane, Top 

Plane, or Right Plane. These planes, visible in the Activity Manager, establish the base for 

drawing the sketch. After selecting the plane, the interface automatically switches to Sketch 

mode, preparing the workspace for geometry definition. 
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3. Creating the Geometry 

To define the 2D geometry, the Rectangle command is accessed from the Sketch toolbar 

and the Corner Rectangle option is selected. The drawing process begins by placing the first 

corner of the rectangle at the Origin point of the coordinate system, indicated graphically by an 

orange point. The shape is extended by moving the cursor, and the second corner is fixed with 

an additional click. 

 
 

4. Adding Dimensions 

To define the proportions of the geometry, the Smart Dimension command is used, located 

in the Sketch toolbar. The dimensioning process involves selecting a side of the rectangle and 

entering the corresponding value (for example, 100 mm for the long side and 50 mm for the short 

side). These steps are repeated for both sides, and upon completion, the defined geometry is 

highlighted in black lines, indicating that the dimensions have been correctly applied. 
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5. Extruding the Sketch 

Once the 2D sketch is defined, it is used to generate the three-dimensional body. From the 

Features tab, the Extruded Boss/Base command is activated. The created sketch is selected, and 

the extrusion height is entered in the configuration window (for example, 20 mm). The operation 

is confirmed by clicking the OK button, resulting in a three-dimensional model visible in the 

graphics area. 
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6. Viewing the Model 

For a detailed inspection of the generated model, the user may employ the following 3D 

navigation commands: 

• Rotate allows the model to be explored from various angles. 

• Zoom to Fit automatically adjusts the display so that the entire model is visible on screen. 

 

 
 

7. Saving the Model 

To preserve the progress made, the file is saved by accessing the File → Save option or by 

using the keyboard shortcut Ctrl + S. The save location is specified and the model is given a 

descriptive name (for example, RectangularBlock). The saving process is completed by 

confirming the Save command. 

 

 
 

1.3.8.2.   Cylinder Modeling 

Cylinder modeling is performed using the fundamental SolidWorks commands Circle, 

Smart Dimension, and Extruded Boss/Base. The steps are designed to ensure a methodical 

understanding of the modeling process and are suitable for didactic use. 
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1. Creating a New Document 

Cylinder modeling begins by launching the SolidWorks application. From the main menu, 

the user selects File → New or uses the keyboard shortcut Ctrl + N. In the New Document 

window, the Part file type is selected, which is specific to the creation of an individual part. Once 

this option is chosen, the process is confirmed by clicking the OK button, opening the main 

working interface. 

 

2. Selecting the Working Plane and Accessing the Sketch Module 

To begin creating the sketch, the Sketch tab is selected from the main toolbar. From the 

Activity Manager on the left side of the screen, the Top Plane is chosen as the working plane, 

which will serve as the base of the cylinder. Upon selecting the plane, SolidWorks automatically 

enters Sketch mode, enabling the definition of the part geometry. 

 

 
 

3. Defining the Circular Base Profile 

To define the base of the cylinder, the Circle command is accessed from the Sketch toolbar, 

located in the upper right corner of the working environment. 

 

 
 

The center of the circle is placed at the Origin, indicated graphically by an orange point. 

The radius is defined by moving the cursor outward and clicking on the circumference. The 
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diameter is then precisely set using the Smart Dimension command: the circumference is 

selected and the desired value is entered in the dimension dialog box (for example, 100 mm). 

Once the dimension is applied, the circle becomes fully defined and is displayed in black. 

 

4. Transforming the Sketch into a Three-Dimensional Body 

Once the sketch is fully defined, Sketch mode is exited by selecting the Exit Sketch 

command. To transform the 2D sketch into a three-dimensional solid, the Features tab is accessed 

and the Extruded Boss/Base command is activated. The previously created circle is selected as 

the base sketch, and the desired cylinder height is entered in the configuration window (for 

example, 100 mm). The extrusion direction can be adjusted as required, and the operation is 

confirmed by clicking the OK button. The three-dimensional model of the cylinder is thus 

generated and displayed in the graphics area. 

 

 
 

5. Model Visualization and Exploration 

The cylindrical model can be explored using the 3D navigation commands available in 

SolidWorks. Rotate View allows the model to be rotated for examination from different 

perspectives. Zoom to Fit adjusts the display so that the entire cylinder is visible on screen. Pan 

View facilitates the translation of the model within the graphics window for more detailed 

inspection. Additionally, the Ctrl + scroll wheel combination can be used to quickly adjust the 

zoom level within the workspace. 

6. Applying a Chamfer at the Cylinder Ends 

To apply an additional finishing feature, a chamfer is added at the ends of the cylinder. 

From the Features tab, the Chamfer command is selected, which allows the creation of an angled 

edge at the boundary of a face. In the Chamfer configuration window, the upper face of the 

cylinder is selected and the required chamfer parameters are entered (for example, 5 mm width 

at a 45° angle). The operation is confirmed by clicking the OK button. 
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The procedure for the Fillet command follows the same logic. Edge rounding is 

performed by selecting the desired faces or edges, specifying the fillet radius in the configuration 

window (for example, 10 mm), and confirming the operation by clicking OK. 
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7. Saving the Created Model 

To preserve the generated model, the File → Save option is selected or the keyboard 

shortcut Ctrl + S is used. In the save dialog window, the file location is specified and a descriptive 

name is assigned to the model, such as Cylinder. Once these details are confirmed by clicking 

the Save button, the saving process is complete and the model is stored in SolidWorks format. 

 

 

1.3.9. Independent Practice Exercises 

The following exercises are proposed for independent completion and feature parts of 

simple geometry, accessible upon completion of the practical applications presented earlier in 

this chapter. Each proposed part consolidates one or more of the operations studied and can be 

completed by combining the sketching, dimensioning, and modeling techniques introduced 

throughout this chapter. 

1.3.9.1. Modeling a Truncated Cone 

 

1.3.9.2. Modeling a Hexagonal Prism 
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1.3.9.3. Washer with Spherical Relief 

 

1.3.10. Assessment Questions 

 

1. What do the terms CAD, CAM, and CAE represent? 

 

 

 

 
2. What is the role of parametric modeling in engineering design? 

 

 

 

 
3. Describe the difference between the Fillet and Chamfer operations and provide a specific 

use case for each in the automotive industry. 

 

 

 

 
4. Which modules of the SolidWorks platform are involved in the development of a technical 

product? 
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2. PARAMETRIC PART MODELING IN SOLIDWORKS 

2.1. Chapter Objectives 

This chapter aims to deepen the parametric modeling of parts within the Part environment, 

through the analysis and completion of components specific to mechanical engineering. 

Emphasis is placed on selecting an appropriate modeling strategy, on the use of constructive 

features, and on understanding the relationship between the geometry of a part, its function, and 

the sequence of modeling operations. 

 

2.2. Learning Outcomes 

Upon completion of this chapter, the student will be able to: 

• analyze a part from both a geometric and functional perspective; 

• establish a coherent parametric modeling strategy; 

• use advanced features to create geometries specific to mechanical parts; 

• correctly apply tools such as Hole Wizard, Helix/Spiral, and Sweep; 

• verify and optimize a three-dimensional model with respect to design requirements. 

 

2.3. Theoretical and Applied Content 

2.3.1. General Considerations on Advanced Part Modeling 

 

In engineering practice, real parts rarely present simple geometries. A pump body, a 

threaded shaft, a helical spring, or a clamping bracket all require a more elaborate approach, both 

in terms of the commands used and the modeling strategy adopted. 

Before beginning any modeling session, the student should analyze the part and consider 

several key questions: what is the basic shape, which operations need to be added and in what 

order, and which elements can be achieved through symmetry or repetition. This prior analysis 

makes the difference between a robust model that can be easily modified at a later stage and one 

that fails at the first dimensional change. 

SolidWorks provides several advanced tools that extend modeling capabilities. The Hole 

Wizard command allows the rapid creation of standardized, threaded, or tapered holes without 

requiring the student to memorize the dimensions imposed by standards, as the program 

manages these automatically. The Helix/Spiral command generates helical paths commonly 

used in the modeling of threads and springs. 

Regardless of the complexity of the part, modeling in SolidWorks remains an orderly and 

logical process in which each step builds upon the previous one, and the correct selection of the 

operation sequence constitutes the foundation of a well-constructed parametric model. 
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2.3.2. Modeling the Housing of an INA Bearing 

 

1. Creating a New Document 

The first step in the part modeling process consists of opening the SolidWorks application 

and selecting File → New → Part to create a new part file. 

 

2. Creating the Base Sketch 

 

Once the document is open, the Right Plane is selected and a new sketch is created. 

 

 
 

Within the selected plane, the base sketch of the part is drawn using the Line command, 

as illustrated below. The sketch is constructed starting from a vertical construction axis traced 

through the origin, which serves as the symmetry reference for all entities. A centered rectangle 

is drawn using Center Rectangle, dimensioned at 66 mm in width and 60 mm in height, after 

which the upper corners are symmetrically chamfered using Sketch Chamfer, with the 

Symmetric relation applied relative to the axis. The lower notch, 20 mm wide and 3 mm deep, is 

also defined using the Symmetric relation, and the 45° angle of its corners is dimensioned using 

an angular dimension. The inner circle with a diameter of 40 mm is placed on the axis at 27 mm 

from the origin, with its center constrained by the On Line relation. The sketch is fully defined 

when all entities are displayed in black. 
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3. Extruding the Profile 

Once the base sketch is complete, it is extruded using the Extruded Boss/Base command. 

Within this command, Mid Plane is selected as the extrusion direction, a depth of 50 mm is 

entered, and the operation is confirmed by clicking the OK button to obtain the desired volume. 

 

 
 

4. Rotating the Model 

To facilitate the selection of the lower edges, the model is reoriented by pressing and 

holding the middle mouse button and rotating until a convenient perspective is obtained, or by 

selecting a predefined orientation from the View Orientation command in the View toolbar. 
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5. Rounding the Upper Edges 

Edge rounding is performed using the Fillet command, accessible from the Features 

toolbar. In the command's PropertyManager, the four upper edges of the part are selected in the 

Items to Fillet field, and a radius of 5 mm is entered in the Radius field. SolidWorks previews 

the result in real time prior to confirmation, allowing the student to verify the correctness of the 

selection. The operation is completed by clicking the OK button. 

 

 
 

6. New Sketch on the Upper Surface 

A new sketch is inserted on the upper surface of the part by right-clicking and selecting 

the Sketch option. From the Sketch toolbar, the Circle command is selected, and the center 

position and radius of the circle are defined. The circle is placed on the surface of the part with a 

diameter of 15 mm, positioned at a distance of 6 mm from the lateral edge using the Smart 

Dimension tool. A Centerline is then drawn to mark the center axis of the part, accessible from 

the Sketch toolbar. To complete the sketch, the Line command is used to draw two segments 

tangent to the circle and a closing line located 2 mm from the lateral edge. The segments lying 

inside the sketch contour are subsequently removed using the Trim Entities command with the 

Power Trim function activated. This function allows the rapid removal of multiple segments in 

a single operation: the left mouse button is held down and the cursor is dragged across the 

segments to be removed, which are deleted as the cursor intersects them. 
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7. Extrude Cut    

From the Features toolbar, the Extruded Cut command is selected, and a cutting depth of 

20 mm is defined in the settings panel. This operation removes material from the part to the 

specified depth of 20 mm in accordance with the configured parameters, ensuring the precision 

and control required in the 3D modeling process and allowing accurate cuts tailored to the 

project requirements. 

 

 
 

8. Hiding Tangent Edges After Applying the Fillet Command 

After applying the Fillet command, the tangent edges automatically generated by the 

operation can be hidden to improve the visual clarity of the model. This is achieved by accessing 

the display options in SolidWorks. The View button is selected from the toolbar, and the 

Hide/Show Edges option is navigated to. Here, the Shaded option can be selected to hide the 

tangent edges, resulting in a cleaner and clearer representation of the part. 
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9. Through Hole 

A new sketch is created on the surface resulting from the cut operation. Using the Circle 

command from the Sketch toolbar, a concentric circle with a diameter of 6 mm is drawn at the 

center of the existing 15 mm diameter circle. 

 
 

10. Through Hole Cut 

To create the required hole, the Extruded Cut command is accessed from the Features 

toolbar. Once activated, the termination condition is changed by selecting the Through All 

option, ensuring complete penetration through the part. The operation is confirmed by clicking 

the OK button, producing the hole in accordance with the specified requirements. 

 

 



Computer-Aided Graphics and Technical Drawing 

46 

 

11. Mirroring the Cutouts Using the Mirror Command 

To streamline the modeling process, the Mirror command is used to create a symmetrical 

replication of the existing features. From the Features toolbar, the Mirror command is selected 

by clicking the arrow next to the Linear Pattern command. In the Mirror Face field, the Right 

Plane is selected as the plane of symmetry, and the previously created cut features are selected 

in the Features to Mirror field. Upon confirming the operation by clicking the OK button, the 

cutout and the through hole are mirrored symmetrically, ensuring the geometric uniformity of 

the part. 

 
 

12. Reorienting the Model 

 

To facilitate the rounding of the lower edges, the model must be reoriented. This is 

achieved by pressing and holding the scroll wheel of the mouse and rotating the model until a 

convenient perspective is obtained. From the View toolbar, the View Orientation command is 

selected, and a corner of the model is chosen from the displayed selector so that the part is viewed 

in an isometric position. 

 

 
 



Computer-Aided Graphics and Technical Drawing 

47 

 

13. Applying Fillets to the Lower Edges 

 To apply the fillets, the Fillet command is accessed from the Features toolbar. In the 

Activity Manager, the Items to Fillet field is clicked and the edges requiring rounding are 

selected individually, with a radius of 0.5 mm specified. The operation is confirmed by clicking 

the OK button, applying the desired fillet to the selected edges. 

 
 

14. Applying a Chamfer at the Ends of the Central Hole 

 

In the final stage, a 1 mm × 45° chamfer is applied at both ends of the central hole to 

improve the surface finish of the part. The Chamfer command is accessed from the Features 

toolbar. In the Activity Manager, the Items to Chamfer field is clicked and the two circular edges 

of the hole are selected. The chamfer parameters of 1 mm and 45° are entered in the designated 

fields, and the operation is confirmed by clicking the OK button, applying the desired 

modification. 
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2.3.3. Modeling the Lower Guide Shoe of the Timing Chain Drive in an Internal Combustion 

Engine 

2.3.3.1. Functional Role of the Part in the Valve Train System 

The timing chain guide shoe may be either a fixed or a movable element, depending on its 

role within the system. Fixed guide shoes are mounted on the engine block and ensure the 

guidance of the chain along a predefined path, preventing lateral deviation. Movable guide shoes 

are articulated on a pivot shaft and act dynamically on the chain through a hydraulic piston 

controlled by the oil pressure from the engine lubrication circuit. The piston permanently keeps 

the movable shoe in contact with the chain, automatically compensating for chain elongation due 

to wear and maintaining optimal tension throughout the entire service life of the valve train. 

 
 

1. Creating the Base Circles 

A new Part file is opened in SolidWorks and the working plane is selected. The choice of 

plane is important as it determines the final orientation of the part in space: Front Plane generates 

the part in a frontal orientation, Top Plane generates it as seen from above, and Right Plane 

generates it as seen from the side. For ring or bushing-type parts, Right Plane is recommended, 

as the axis of revolution naturally coincides with the horizontal axis of the coordinate system. 

The Circle command from the Sketch toolbar is used to draw two concentric circles, which serve 

as the base elements for the subsequent construction of the 3D model. 
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2. Extruding the Base Circles   

The base circles are extruded using the Extruded Boss/Base command from the Features 

toolbar. Two extrusion directions are defined: a thickness of 12 mm is entered for the first 

direction and 4 mm for the second direction in the Activity Manager. The command is completed 

by clicking the OK button, resulting in a cylinder with the specified dimensions. 

 

 
 

3. Creating the Base Sketch for the Lower Guide Shoe 

 

The first step consists of selecting Right Plane as the working plane. From the origin, a 

vertical symmetry axis is traced to an appropriate height using the Centerline command from 

the Sketch toolbar. Attention must be paid to the verticality relation: when the yellow verticality 

indicator appears next to the cursor, a click is made to lock the symmetry axis in the desired 

vertical position. 

 

 
 

The outer edge of the cylinder is converted to begin a new sketch. The outer edge is 

selected, and the Convert Entities command is activated from the Sketch toolbar. This command 

copies the part edge into the current sketch, allowing it to be used as a reference element for 

subsequent modeling operations. 
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Using the Circle command from the Sketch toolbar, an additional circle with a diameter 

of 10 mm is constructed. This circle is positioned at a distance of 35 mm and 8 mm respectively 

from the symmetry axis. The precise dimensioning and positioning of the circle is carried out 

using the Smart Dimension command from the Sketch toolbar. The command is activated, the 

circle is clicked to define the 10 mm diameter, and the origin and symmetry axis are then selected, 

followed by the circle, to specify its position relative to the axis. This process ensures the 

geometric precision required in the design. 

 

 
 

The Line command is activated from the Sketch toolbar to draw a line tangent to the large 

circle. A left click is made on the left side of the circle, and the tangency and verticality relations 

appear next to the cursor, indicated in yellow. Once the correct position is confirmed, a left click 

is made to create the vertical line. With the Smart Dimension command active, the line segment 

is clicked and a length of 42 mm is entered in the dimension dialog box, establishing the exact 

length of the line. This process ensures the geometric precision and alignment required in the 

design. 
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The next step involves drawing a circular arc tangent to both the base circle and the upper 

circle. The 3 Point Arc command is selected from the Sketch toolbar. The arc is created through 

three clicks, in accordance with the specifications of this arc type. The first left click is made on 

the large circle, the second click on the lower point of the small circle, and the third click defines 

the vertical position of the arc relative to the origin of the small circle. The arc is positioned so 

that its center of origin lies on the right side. The Smart Dimension command is then used to 

dimension the arc, entering a radius of 60 mm.  

 

 
 

  To fully define the arc segment, the base circle is first selected, followed by the arc, while 

holding the Ctrl key. In the Activity Manager, a series of geometric relations will appear in the 

properties panel. The Tangent relation is selected and confirmed by clicking OK. 
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The right side of the sketch contour is completed with a circular arc, which is initially drawn 

approximately using the 3 Point Arc command, with the lower end connected to the small circle. 

It is essential to ensure that the center of the arc is positioned on the right side. The radius of the 

arc and the positions of both endpoints relative to the symmetry axis are then dimensioned using 

the Smart Dimension command, with the upper endpoint also referenced relative to the 

symmetry axis. 

 
 

The part contour is constructed using the Sketch toolbar commands, incorporating the 

straight segment and the two circular arcs in accordance with the specified dimensions. Careful 

attention must be paid to the geometric relations to ensure that the entire sketch is fully defined, 

which is confirmed when all blue lines turn black. To obtain the final contour shape, the Trim 

Entities command is used to remove unwanted segments, resulting in a clean contour suitable 

for extrusion. 
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4. Extruding the Sketch to Obtain the 3D Shape 

The Extruded Boss/Base command is accessed from the Features toolbar, and the extrusion 

condition is set to Mid Plane with a thickness of 18 mm. The Merge Result option is checked to 

merge the two extrusions, and the previously created sketch must be visible in the Selected 

Contours field. Once these parameters are configured, the operation is confirmed by clicking the 

OK button, generating the initial three-dimensional shape. 

 

 
 

5.  Creating the H-Profile Through a Cut Operation 

To create the lateral cutout, the corresponding surface is selected with a left click, making 

it the active plane on which the sketch will be defined. After selection, a right-click opens a 

contextual menu from which the Sketch command is launched, allowing a new working sketch 

to be created. 
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To select the part contours and convert them into the current sketch, the Ctrl key is held 

down and the desired edges are selected. This step allows the contours to be integrated into the 

active sketch. 

 
 

Once the sketch is converted, the lower portion of the circle can be trimmed using the Trim 

command, available in the program toolbar. This functionality allows the selective removal of 

geometric segments, contributing to the creation of a precise sketch adapted to the design 

requirements. 

 

 
 

The contour is duplicated using the Offset command from the Sketch toolbar. A value of 2 

mm is entered as the offset distance between the lines, and the Reverse option is selected to bring 

the sketch inside the part. The operation is completed by clicking the OK button. 
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The Line command is accessed and a line tangent to the circular arc is drawn in place of 

the missing segment. The Trim command is then used to remove the unwanted lines from the 

sketch, resulting in a well-defined contour ready for the cut operation. 

 

 
 

From the Features toolbar, the Extruded Cut command is used to remove material from 

the interior of the part, bounded by the previously created sketch. The cut is performed to a depth 

of 5 mm, creating a precise cutout in accordance with the geometry defined by the sketch. 
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To perform this operation, Right Plane is selected as the reference plane and the Cut-

Extrude 1 operation is selected in the Features to Mirror field. This process ensures the creation 

of a symmetrical copy of the cutout relative to the specified reference plane. 

   
 

To create the lateral guide on the side of the shoe, a new sketch is constructed on the lateral 

surface of the part, allowing a portion of its edge to be converted. After selecting the edges as 

shown in the corresponding figure, the Convert Entities command is invoked from the toolbar. 

The selected edges appear in the selection window, and the process is completed by clicking OK, 

ensuring the integration of the edges into the active sketch. 
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From the Features toolbar, the Extruded Boss/Base command is selected. With the Thin 

Feature option activated, the edge extrusion is performed. It is essential to verify the orientation 

of the arrow, which must point toward the model. The arrow direction can be reversed using the 

Reverse Direction button, marked with a double arrow. A value of 2 mm is entered in the 

direction field, and a thickness of 2 mm is also specified. The process is completed by clicking 

the OK button. 

 

 
 

The guide is mirrored using the Mirror command from the Features toolbar. Right Plane 

is selected as the mirror plane, and the Extrude-Thin1 operation is selected from the feature tree 

in the Features to Mirror field. The process is completed by clicking the OK button, ensuring the 

creation of a symmetrical copy of the guide relative to the specified plane. 
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A through hole is created in the part using the Hole Wizard command from the Features 

toolbar. After accessing the command, the Counterbore hole type is selected. A depth of 25 mm 

is entered for the hole dimension. The Positions menu is then accessed to specify the hole 

location. The cursor is positioned over the circular arc until its origin point appears, at which 

point a left click is made on the origin to place the hole concentrically with the part edge in the 

semicylinder region. This process ensures the precise alignment of the hole with respect to the 

part geometry. 
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Fillets are applied using the Fillet command, accessible from the Features toolbar. By 

selecting the edges or faces of the skate one at a time, they will appear listed in the Property 

Manager window. A fillet radius value of 0.5 mm is entered, and the software provides a preview 

option for preliminary verification. Clicking the OK checkmark confirms the operation, 

producing a final model with fillets applied according to the specified parameters. 

 

 
 

2.3.4. Modeling a Helical Compression Spring with Variable Pitch and Diameter 

  

1. Creating a New Part File 

To begin modeling, navigate to File → New, then select the Part document type and 

confirm with OK. 

 

2. Creating a Sketch for the Base Diameter of the Spring 

An appropriate working plane is selected, such as the horizontal plane (Top Plane). The 

Sketch command is then accessed from the Sketch menu bar to create a sketch containing a circle 

centered at the origin with a diameter of 160 mm, which defines the base diameter of the spring. 

The circle's dimension is set using the Smart Dimension command by selecting the circle. In the 

properties window that opens, the value 160 mm is entered and confirmed by clicking the OK 

checkmark. 
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3. Defining the Spring Profile Using the Helix Command 

After completing the circle sketch, the Curves command is accessed from the Features 

toolbar, and the Helix and Spiral command is selected from its dropdown menu. This opens the 

options menu for defining a helical or spiral curve, allowing the configuration of the necessary 

parameters for generating the spring. 

 

 
 

The helix parameters are set using the PropertyManager. As the first parameter, the 

Variable Pitch option is selected, and each entry in the corresponding table is filled in according 

to the reference figure, including parameters such as pitch, number of revolutions, height, and 

diameter. 

The helix will be displayed in the preview according to the entered data. If rotation is 

needed to verify the sketch, the middle mouse button can be held down while moving the cursor 

to adjust the viewing angle. Clicking the OK checkmark generates the helix. 

These parameters influence the shape and behavior of the helical spring, ensuring the 

precision required in the design process. 

 

 



Computer-Aided Graphics and Technical Drawing 

61 

 

 
 

4. Creating the Cross-Sectional Profile of the Spring 

A plane perpendicular to the helix path is selected, such as the Right Plane, and a new 

sketch is opened using the Sketch command. The cross-sectional profile of the spring is drawn 

as a circle with a diameter of 14 mm, placed at an arbitrary position on the plane. By holding the 

Ctrl key and simultaneously selecting the center of the circle and the first coil, a series of 

geometric relations becomes available, among which the Make Pierce option appears. Selecting 

this relation links the circle to the origin of the helix, ensuring correct alignment of the cross-

sectional profile with the helical path. 
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5. Obtaining the Spring Volume Using SWEEP 

Using the Sweep command from the Features menu bar, the drawn profile is selected as 

the cross-section and the previously defined helical path is selected as the trajectory. SolidWorks 

automatically generates the helical spring based on these settings, maintaining a spring diameter 

of 160 mm and a coil diameter of 14 mm, after which the OK checkmark is clicked to complete 

the operation. To hide the helix, right-click on Helix/Spiral1 in the feature tree and select the 

Hide option from the context menu. This action removes the helix from view, retaining only the 

geometry of the generated spring. 

 

 
 

6. Trimming the Lower Base of the Spring Using the Cut Command 

The Cut With Surface command from the Surface menu bar is used to remove material 

from the ends of the spring. Top Plane is clicked to select the working plane, after which the Cut 

With Surface command is accessed. The arrow direction must be oriented downward, indicating 

the direction in which material is cut from the model. Clicking the OK checkmark then confirms 

the operation, permanently removing the material and completing the cut. 
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7.  Trimming the Upper Base of the Spring Using the Cut Command and Finalizing the Model 

To repeat the cutting procedure at the upper base, a new cutting plane must be 

constructed. Top Plane is clicked, then from the Features menu bar the arrow next to Reference 

Geometry is expanded, where the Plane command is located. In the PropertyManager, the 

correct position of the new plane is configured: Top Plane will appear at First Reference, while 

the upper end of the helix must be selected at Second Reference, thereby defining the plane's 

position. The command is completed by clicking the green OK checkmark. 

Finally, the previous step (5) is repeated to trim the upper end, paying attention to the 

arrow orientation, which must point upward at this stage of the trimming operation. 

 

 
 

The completed model is presented below, and as can be observed, both the pitch and 

diameter are variable in this compression spring. To create a section view, the Section View 

command is accessed from the View toolbar. In the command's PropertyManager, Right Plane 

is selected in the Section 1 field as the cutting plane, this being the axial plane passing through 
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the axis of the spring. After confirming with the OK checkmark, the model is displayed in section 

view, and the visualization can be toggled between sectioned and full view using the Section 

View button in the toolbar. 

 

 
 

2.3.5. Independent Practice Exercises 

The exercises proposed below are primarily didactic in nature, designed to consolidate and 

deepen the use of the commands presented throughout the chapter. Working through them will 

provide practice with both the Sketch module commands and the specific operations of the 

Features module, thereby developing the ability to approach parametric modeling of parts with 

varied geometry. 

Dimensions not specified in the reference figures are to be determined constructively, 

respecting the visual proportions of the part and the general principles of technical 

representation in engineering drawings. 
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2.3.5.1. Modeling a Cylindrical Body with Opposing Spherical Interior Cavities 

 

2.3.5.2. Cylindrical Body with Opposing Exterior Domes 

 
 

 

2.3.5.3. Cylindrical Part with Orthogonal Conical Cutouts 
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2.3.5.4. Modeling a Dome-Shaped Body 

 
 

2.3.5.5. Torsion Spring with Straight Arms 

 
 

2.3.5.6. Flat Spiral Spring with Mounting Hooks 
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2.3.6. Assessment Questions 

 

1. In what situations is the use of the Hole Wizard command recommended? 

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________ 

2. What is the role of the Helix/Spiral curve in spring modeling? 

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________ 

 

3. Why does the order of operations affect the quality of the parametric model? 

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________ 

 

4. What are the main steps in establishing a modeling strategy? 

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________ 
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3. MODELING THE COMPONENTS OF A DIESEL FUEL INJECTOR 

3.1. Chapter Objectives 

This chapter aims to develop an integrated applied approach through the individual 

modeling of the components of a fuel injector. The case study allows the correlation of parametric 

modeling concepts with the functional analysis of parts and with an understanding of the role of 

each component within a real mechanical subassembly (Figure 3.1). 

 

 
 

Figura 3.1 3D model of the fuel injector created in SolidWorks 

Modeling the components of a fuel injector is an essential process in the development and 

optimization of injection systems for internal combustion engines. Through the use of a modeling 

application, precise 3D models of individual parts can be created such as the injector body, 

injector needle, pressure spring, and nozzles, enabling functional analysis, compatibility 

verification, and simulation of behavior under real operating conditions. This exercise not only 

strengthens computer-aided design (CAD) skills, but also familiarizes students with the technical 

specifications and functional requirements of a complex injection system. Modeling the injector 

in a dedicated application therefore serves as a valuable tool for developing a thorough 

understanding of design and manufacturing processes, as well as for the technical preparation 

of future engineers. 

 

3.2. Learning Outcomes 

By the end of this chapter, the student will be able to: 

 

• to identify the main components of a fuel injector;  

• to correlate the constructive shape of components with their functional requirements 

and assembly conditions;  

• to model individual parts with varying degrees of geometric complexity;  

• to correlate the constructive shape of components with their functional requirements. 
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3.3. Theoretical and Applied Content 

3.3.1. Injector Body Modeling 

 
 

1. Creating a New Part File 

The first step in the part modeling process consists of opening the SolidWorks application 

and selecting File → New → Part to create a new part file. 

 

2. Sketching the Base Profile 

To begin modeling the injector body, the Right Plane is selected as the working plane by 

right-clicking on it, and sketch mode is opened using the Sketch command.  

  

3. Creating and Dimensioning the Profile of the Injector Body 

In the first phase, using the commands from the Sketch toolbar, the Centerline command 

is used to draw a symmetry axis from the origin along the horizontal. This axis serves as a 

reference element for the alignment and symmetric construction of the profile. The outer contour 

of the injector body profile is then drawn, paying close attention to geometric details and 

compliance with the technical specifications. The Smart Dimension command is used to define 

the geometric dimensions, respecting the measurements shown in the sketch below.  
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4. Generating the Body by Revolution 

After completing the sketch, the Revolve Boss/Base command is accessed from the 

Features toolbar. In the PropertyManager, the Axis of Revolution box is clicked, and the 

symmetry axis around which the rotation is to be performed is then selected. In the Direction 

window, the Blind option is chosen, and the rotation angle is set to 360 degrees. 

In the Selected Contours section, the sketch created in the previous step is selected. The 

software provides an instant preview of the volume to be generated, displayed in a semi-

transparent yellow color. After confirming the settings by clicking the green OK checkmark, the 

3D volume is generated automatically, producing the injector body in its final form. This process 

highlights the efficiency and precision of the Revolve command in transforming a 2D profile into 

a three-dimensional model. 
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5. Representing Threads Using the Cosmetic Thread Command 

Since components such as the nozzle cap and fuel line are mounted on the injector body, 

it is necessary to represent threads on both ends. For this purpose, the Cosmetic Thread option 

is used, which allows the visual representation of the thread without geometrically modifying 

the 3D model. 

From the menu bar, the Insert section is accessed, where the Annotations submenu is 

opened. The Cosmetic Thread command is then selected. This functionality adds a symbolic 

representation of the thread, complying with technical standards and specifications, without 

increasing the complexity of the model. 

 

 

 
 

The Cosmetic Thread command is launched with a left click. In the PropertyManager, a 

series of input fields appear which, when correctly configured, allow a thread to be obtained 

according to the specified requirements. In the first phase, the Thread Settings box is clicked, 

and the circular edge on the model where the thread representation is desired is then selected. 

Since the sketch also includes a relief groove, the Up to Next option is chosen instead of 

Blind, ensuring that the thread extends to the next surface. The software automatically 

recognizes the diameter of the selected edge, and the corresponding field displays a value of 20 

mm for the diameter. After confirming the settings by clicking OK, a circle is created representing 

the minor diameter of the external thread. This process ensures an accurate and compliant thread 

representation, meeting the technical requirements of the model. 
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Since the thread visualization feature is not active by default, the software does not 

display the configured thread. To enable this option, the general document settings are accessed. 

In the Document Properties menu, the Shaded Cosmetic Threads option is checked. After 

selecting this option, OK is clicked to apply the changes and display the thread correctly. This 

step ensures a clear and realistic visual representation of the thread, facilitating model 

verification and validation. 

 

 
 

Following the same steps as before, an M12 thread is added on the side where the fuel line 

is connected. Using the Cosmetic Thread command, the corresponding circular edge is selected. 

Since the visualization option is already active, the thread appears immediately on the model 

after clicking the OK checkmark. 
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6. Applying a Chamfer to the Thread Start 

To represent the thread start, the Chamfer command is clicked from the Features toolbar. 

In the PropertyManager, the two edges corresponding to the thread ends are selected in the 

Items to Chamfer box. In the Chamfer Parameters section, a value of 1 mm at an angle of 45 

degrees is entered. After completing the settings, the OK checkmark is clicked and the chamfer 

operation is finalized. 

 

 
 

7.  Creating the Wrench Flat on the Injector Body 

The injector body must also be provided with a wrench flat. To create the two flat surfaces, 

a 22 mm section is cut from the portion with the maximum diameter of the body. 

As a first step, a new sketch is created on the circular surface highlighted in blue in the 

figure below, by right-clicking and selecting Sketch. From the Sketch toolbar, the Center 

Rectangle command is accessed to draw a rectangle centered with respect to the origin. Using 

the Smart Dimension command, each side of the rectangle is selected and the dimensions are 

defined: a width of 22 mm and a length of 30 mm. The values are entered in the dimensioning 

window and confirmed by clicking the OK checkmark. 
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After completing the sketch, the Extruded Cut command is accessed from the Features 

toolbar. In the command's PropertyManager, the execution direction is set by selecting the Blind 

option with a depth of 20 mm. It is essential that the Flip Side to Cut option is activated, as this 

ensures material removal on the outside of the sketch profile. After configuring all parameters, 

the command is completed by clicking the OK checkmark. 

 

 
 

 

8. Creating the Fuel Inlet Hole 

The axial high-pressure bore of the injector body consists of two coaxial sections with 

different diameters, which from a manufacturing standpoint requires two distinct drilling 

operations performed successively along the same axis. In SolidWorks, each section is modeled 

through a separate Cut-Extrude operation. For the first section, Top Plane is right-clicked, 

Sketch is selected from the context menu to open a new sketch, and the circle corresponding to 

the first section of the bore is then drawn. 
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Using the Centerline and Line commands from the Sketch toolbar, a vertical symmetry 

axis is first drawn. A segment is then drawn from the upper contour, respecting the indicated 

geometric constraints. The Smart Dimension command is used to apply angular and linear 

constraints, enabling precise definition of distances and angles. This process ensures the 

geometric accuracy of the sketch and prepares the model for subsequent operations. 

 
Using the Centerline and Line commands from the Sketch toolbar, a vertical symmetry 

axis is first drawn. A segment is then drawn from the upper contour, respecting the indicated 

geometric constraints. The Smart Dimension command is used to apply angular and linear 

constraints, enabling precise definition of distances and angles. This process ensures the 

geometric accuracy of the sketch and prepares the model for subsequent operations.. 
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The software allows the bore to be created in a single step; however, from a manufacturing 

standpoint this is not feasible. The bore is therefore created in stages, respecting the actual 

fabrication process. 

The model is rotated by holding down the middle mouse button until a perspective is 

obtained that allows visual access to its lower base. After repositioning, the lower base surface is 

selected with a left click, and the CTRL+8 key combination is then pressed to orient the view 

perpendicularly to the selected surface, bringing the model into a convenient working position. 

To complete the bore entirely, the Hole Wizard command is selected from the Features toolbar. 

In the PropertyManager, the hole type is set to Hole, with the ISO standard and Drill Size type 

selected. 

In the Hole Specifications section, a diameter of 1.5 mm is selected from the available list, 

and the End Condition is set to Blind with a depth of 35 mm. In the Position menu, the hole 

position is established by ensuring it is aligned horizontally with the origin, and a left click is 

used to place the reference point. Using the Smart Dimension command, the position of the hole 

is dimensioned at 8 mm from the origin, after which the OK checkmark is clicked to complete 

the operation. 

 

 
 

Using the Section View command, the bore created through the injector body can be 

examined. Section View is clicked, and Top Plane is then selected from the menu that appears 

as the cutting plane. If the two bores intersect according to the specifications, this confirms that 

the previous steps were carried out correctly. 
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9. Creating the Bearing Surface for the Spring 

Another essential element that must be modeled is the bearing surface for the spring. Since 

this is located inside the 10 mm diameter bore, the model is rotated to a convenient position that 

allows visual access to the flat inner circular surface, which is then selected with a left click and 

the sketch is opened using the Sketch command from the context menu. Using the Circle 

command, two concentric circles are drawn with diameters of 4 mm and 9 mm respectively. 

Dimensional accuracy is ensured through the use of the Smart Dimension command, which 

allows the exact definition of the circle diameters. After entering the values, each dimension is 

confirmed by clicking the OK checkmark. 

 

 
 

To extrude the sketch, the Extruded Boss/Base command is accessed. In the 

PropertyManager, the Blind option is selected in the Direction section, and a value of 0.5 mm is 

entered in the dimension field. To ensure the extrusion is integrated into the existing solid, the 

Merge Results option is checked, thus avoiding the creation of a separate solid. Finally, the OK 

checkmark is clicked to complete the extrusion process. 
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10. Creating the Cutout for the Fuel Return Circuit 

To allow the attachment of hoses for the fuel return circuit on the injector body, a cutout 

must be created. The process begins by selecting the upper flat cylindrical face of the injector 

according to the blue highlighted area, where a new sketch is created using the Sketch command. 

Within this sketch, a vertical symmetry axis is drawn using the Centerline command, after which 

the cutout profile is outlined using the Circle command, respecting the dimensions and geometry 

required for optimal fastening. The dimensioning of the circle, with a diameter of 8 mm and a 

specific distance from the origin along the vertical direction, is carried out using the Smart 

Dimension command from the Sketch toolbar. 

 

 
 

The cutout is created using the Extruded Cut command from the Features toolbar. After 

activating this command, the Blind option is selected in the PropertyManager for the cut 

direction, and a depth of 16 mm is set. The circle with a diameter of 8 mm is then chosen in the 

Selected Contours field, and the OK checkmark is clicked to confirm. It is important to pay 

attention to the cut direction, which must be oriented toward the outside of the part body. If 

reversing the cut direction is necessary, this is done using the Reverse Direction button, 

represented by a double arrow, available in the PropertyManager. 
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11. Creating the Sketch for the Fuel Return Bore 

The fuel return bore in the injector body serves to allow excess fuel to reach the return 

circuit, from where it is directed back to the fuel tank. To create this configuration, the Right 

Plane is selected and a new sketch is opened using the Sketch command. Using the Line 

command, a straight line is drawn, positioned and dimensioned according to the figure below. 

After completing the drawing, the operation is confirmed by clicking the OK checkmark. 

 

 
 

12. Creating the Fuel Return Bore 

To create the fuel return bore, the Swept Cut command is used from the Features toolbar. 

In the configuration window within the PropertyManager, the Circular Profile option is selected 
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in the Profile and Path section, and the line from the previous sketch is then chosen as the path. 

The cut diameter is set to 4 mm, and the operation is completed by clicking the OK checkmark. 

 

 
 

13. Saving the Document 

From the menu bar, the model is saved to the predefined directory using the Save button. 

 
 

3.3.2. Modeling the Nozzle Cap 

1. Creating a New Part File 

The first step in the part modeling process consists of opening the SolidWorks application 

and selecting File → New → Part to create a new part file. 

 

2. Sketching the Base Profile 

To begin modeling the cap, the Right Plane is selected as the reference plane by right-

clicking on it, and sketch mode is opened using the Sketch command. To ensure dimensional 

accuracy, the Smart Dimension command is used. 
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3. Creating and Dimensioning the Profile of the Nozzle Cap 

In the first phase, using the commands from the Sketch toolbar, the Centerline command 

is used to draw a symmetry axis from the origin along the horizontal. This axis serves as a 

reference element for the alignment and symmetric construction of the profile. The outer contour 

of the nozzle cap profile is then drawn, paying close attention to the geometric details shown in 

the figure below. 

 

 
 

4. Generating the Body by Revolution 

After completing the sketch, the Revolve Boss/Base command is accessed from the 

Features toolbar. In the PropertyManager, the Axis of Revolution box is clicked, and the 

symmetry axis around which the rotation is to be performed is then selected. In the Direction 

window, the Blind option is chosen, and the rotation angle is set to 360 degrees. 

In the Selected Contours section, the sketch created in the previous step is selected. The 

software provides an instant preview of the volume to be generated, displayed in a semi-

transparent yellow color. After confirming the settings by clicking the green OK button, the 3D 

volume is generated automatically, producing the nozzle cap body in its final form. This process 
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highlights the efficiency and precision of the Revolve command in transforming a 2D profile into 

a three-dimensional model. 

 

 

 
 

5.  Representing Threads Using the Cosmetic Thread Command 

Since components such as the nozzle cap and fuel line are mounted on the injector body, 

it is necessary to represent threads on both ends. For this purpose, the Cosmetic Thread option 

is used, which allows the visual representation of the thread without geometrically modifying 

the 3D model. 

From the menu bar, the Insert section is accessed, where the Annotations submenu is 

opened. The Cosmetic Thread command is then selected. This functionality adds a symbolic 

representation of the thread, complying with technical standards and specifications, without 

increasing the complexity of the model. 
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The Cosmetic Thread command is launched with a left click. In the PropertyManager, a 

series of input fields appear which, when correctly configured, allow a thread to be obtained 

according to the specified requirements. In the first phase, the Thread Settings box is clicked, 

and the circular edge on the model where the thread representation is desired is then selected. 

Since the sketch also includes a relief groove, the Up to Next option is chosen instead of 

Blind, ensuring that the thread extends to the next surface. The software automatically 

recognizes the diameter of the selected edge, and the corresponding field displays a value of 15 

mm for the diameter. After confirming the settings by clicking the OK checkmark, a circle is 

created representing the minor diameter of the external thread. This process ensures an accurate 

and compliant thread representation, meeting the technical requirements of the model. 

 

 

 
 

Since the thread visualization feature is not active by default, the software does not 

display the configured thread. To enable this option, the general document settings are accessed. 

In the Document Properties menu, the Shaded Cosmetic Threads option is checked. After 

selecting this option, OK is clicked to apply the changes and display the thread correctly. This 

step ensures a clear and realistic visual representation of the thread, facilitating model 

verification and validation. 
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Following the same steps as before, an internal M24 thread is added. Using the Cosmetic 

Thread command, the corresponding circular edge is selected. Since the visualization option is 

already active, the thread appears immediately on the model after clicking the OK checkmark. 

 
 

6. Creating the Hexagon Sketch for the Wrench Opening 

The upper flat surface is selected as shown in the figure below, highlighted in blue, to 

create a new sketch. To ensure an adequate wrench opening required for tightening or loosening 

the nozzle cap, the Polygon command is used from the Sketch toolbar. After activating this 

command, the origin of the hexagon is positioned at the center of the model. The Smart 

Dimension command is then used to set its dimension to 27 mm, ensuring conformity with the 

figure below. 

 

 
 

7. Creating the Hexagonal Cutout 

To create the necessary hexagon, the Extruded Cut command is used. After activating it, 

the Blind option is selected in the direction section of the PropertyManager, and the cut depth 

is set to 20 mm. To ensure the correct orientation of the cutout and generate the hexagon on the 

model, the Flip Side to Cut option is activated. 
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8. Applying a Chamfer to the External Thread Start 

To create a chamfer at the start of the external thread, the Chamfer command is used from 

the Features toolbar. After activating the command, the starting edge of the external thread is 

selected. In the Chamfer Parameters section, a value of 1.5 mm at an angle of 45 degrees is set, 

ensuring a correct transition that meets the technical requirements. 

 

 
 

9. Applying a Chamfer to the Hexagon Faces 

To create chamfers on both faces of the hexagon, the Chamfer command cannot be used, 

as it operates exclusively on linear or circular edges of a solid and is unable to generate a uniform 

chamfer along the hexagonal contour with the desired angle and depth. In this sketch, a circle 

with a diameter of 27 mm is drawn, which will serve as the basis for creating the chamfer 

according to the technical specifications. 
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To perform the chamfer, the Extruded Cut command is used. After activating it, the cut 

depth is set to 10 mm in the direction section of the PropertyManager. The Flip Side to Cut 

option is then activated to reverse the cut direction, and the Draft option is selected, where an 

angle of 60 degrees is entered. After correctly configuring all parameters, the operation is 

confirmed by clicking the OK checkmark. 

 

 
 

Following the same approach as the previous step, a new sketch is created on the other face 

of the hexagon by right-clicking, after which the Circle command is selected from the toolbar. A 

click is made at the origin to begin the circle, then a second click is made at an approximate 

diameter corresponding to the wrench opening. The Smart Dimension command is activated 

from the Sketch toolbar, and the circle is clicked to enter a diameter of 27 mm in the Modify 

window. 
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To perform the chamfer, the Extruded Cut command is used. After activating it, the cut 

depth is set to 10 mm in the direction section of the PropertyManager. The Flip Side to Cut 

option is then activated to reverse the cut direction, and the Draft option is selected, where an 

angle of 60 degrees is entered. After correctly configuring all parameters, the operation is 

confirmed by clicking the OK checkmark. 

 
 

10. Saving the Document 

From the menu bar, the model is saved using the Save command, assigning it the name 

capac_pulverizator. After saving, the current window is closed, and a new Part file is opened via 

File → New → Part to begin modeling the next component. 

 

 

3.3.3. Modeling the Helical Compression Spring 

1. Creating a New Part File 

To initiate the 3D modeling process, the main menu bar is accessed and the New 

command is selected. In the dialog window, the Part category is chosen, and the selection is 

confirmed by clicking the OK checkmark. 
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2.  Creating the Base Sketch 

To initiate the modeling process, a new sketch is created by activating the Sketch 

command. The Top Plane is then selected as the working plane. Within this sketch, a circle is 

drawn that defines the diameter of the helical spring. Its dimension is set using the Smart 

Dimension command, ensuring conformity with the technical specifications of the fuel injector. 

 

 
 

3. Generating the Helical Path 

To define the helical path of the spring, the Helix command is used from the Features 

toolbar. The previously created circle is selected, and the essential parameters are configured in 

the PropertyManager, including pitch, number of coils, and helix direction. Depending on the 

technical requirements, either a constant or variable pitch can be chosen. 

In this case, the constant pitch option is selected by activating the Pitch option. A height 

of 34 mm is then set, and a value of 11 mm is entered in the Revolution box. After configuring 

these parameters, the OK checkmark is clicked, generating the helix. 
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4. Creating the Cross-Section and Generating the Spring 

After defining the path, a new sketch is created on a perpendicular plane using the Sketch 

command. To generate a plane perpendicular to the end of the helix, the Plane command is 

accessed from the toolbar, and the arrow in the Reference Geometry section is clicked to display 

the available subcommands. 

In the PropertyManager, the First Reference window is clicked and the helix is selected. 

The corresponding box is then clicked to set the second reference, and the point located at the 

upper end of the helix is selected. The Perpendicular and Coincident relations must be active to 

ensure correct alignment of the plane with the helical path. 
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The newly created plane is right-clicked and a sketch is initiated using the Sketch 

command. Within this sketch, a circle is drawn that will define the cross-sectional profile of the 

spring wire. Its diameter of 2 mm is set using the Smart Dimension command, ensuring 

conformity with the technical requirements of the model. 

 

 
 

To generate the helical spring, the Sweep command is used from the Features toolbar. In 

the PropertyManager, the previously defined circle is selected as the cross-sectional profile and 

the created helical path is selected as the trajectory. After correctly configuring the parameters 

and confirming the settings by clicking the OK checkmark, the three-dimensional model of the 

spring is generated automatically. 

 
 

5. Trimming the Spring Ends 

To perform the trimming operation, a new sketch is created on an appropriate plane such 

as the Right Plane. Within this sketch, the necessary geometry is outlined using the Rectangle 

command from the Sketch toolbar. This step allows the area to be removed to be defined, 

ensuring precision and conformity with the technical requirements of the model. 
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To finalize the model, the ends of the spring must be removed to ensure an optimal contact 

surface. This is accomplished using the Extruded Cut command. In the PropertyManager, Mid 

Plane is selected for the direction, and the cut depth is set to 21 mm. An essential aspect of this 

step is checking the Flip Side to Cut option, which ensures correct trimming of the spring ends. 

After confirming the operation, the model of the helical compression spring intended for 

the fuel injector is complete, meeting the technical and functional requirements imposed by the 

design. 

 

 
 

6. Saving the Document 

The model is saved using the Save command from the menu bar, assigning it the name 

arc in the dialog window. After saving, the current window is closed. 
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3.3.4. Modeling the Spacer Washer 

1. Creating a New Part File 

To begin modeling, a new part file is created using the New Part option from the menu 

bar. This step establishes an appropriate working environment for the design process. 

 

 
 

2. Defining the Initial Contour 

An appropriate working plane is selected, Front Plane, and a new sketch is created using 

the Sketch command. 

 
    

 Within this sketch, two concentric circles are drawn to define the outer and inner contours 

of the spacer washer, with diameters of 4 mm and 9 mm respectively. Their dimensions are set 

using the Smart Dimension command from the Sketch toolbar. 

 

 
 

3. Generating the Volume 

To convert the sketch into a three-dimensional model, the Extruded Boss/Base command 

is used from the Features toolbar. In the PropertyManager, the extrusion direction is configured 

and a thickness of 1 mm is entered. After confirming the settings, the 3D model of the washer is 

generated. 
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4. Saving the Model 

To complete the process, the model is saved using the Save button from the menu bar. In 

the save dialog window, the part is named Saiba_distantier and stored in the predefined directory. 

 

 
 

3.3.5. Modeling the Adjustment Washer 

Modeling an adjustment washer in SolidWorks involves a series of essential steps, making 

use of the software's functionality to ensure geometric precision and conformity with technical 

requirements. The spacer washer maintains a fixed distance between components, preventing 

direct contact, while the adjustment washer allows fine-tuning of their position. The former 

ensures alignment, while the latter provides adaptability for precise adjustments. 

 

1. Creating a New Part File 

To initiate the modeling process, the menu bar is accessed and the New command is used. 

In the selection window, the Part option is chosen, and the selection is confirmed by clicking the 

OK checkmark, thereby generating a new file for part modeling. 
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2. Creating a Base Sketch 

The Sketch command is used from the Sketch toolbar, and Top Plane is selected as the 

working plane. 

 

 
 

Within this sketch, two concentric circles are drawn using the Circle command. The outer 

and inner diameter dimensions are set using the Smart Dimension command, respecting the 

technical specifications of the injector. 

 
 

3. Generating the Three-Dimensional Model 

To transform the sketch into a 3D model, the Extruded Boss/Base command is used from 

the Features toolbar. In the PropertyManager, the extrusion direction is set and a thickness of 

0.3 mm is entered. After confirming the parameters by clicking the OK checkmark, the three-

dimensional model of the washer is generated. 

 

 
 

4. Saving the Model 

To complete the process, the model is saved using the Save button from the menu bar. In 

the save dialog window, the part is named saiba_de_reglaj, and the storage location is selected 

according to the user's preferences. 
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3.3.6. Modeling the Spring Retainer 

The spring retainer within a fuel injector serves to ensure uniform distribution of the 

spring force onto the valve, contributing to the sealing and optimal operation of the injector. 

 

1. Creating a New Part File 

To initiate the modeling process, the menu bar is accessed and the New command is used. In the 

selection window, the Part option is chosen, and the selection is confirmed by clicking the OK checkmark, 

thereby generating a new file for part modeling. 

 

 
 

2.  Creating the Initial Sketch of the Spring Retainer 

To begin modeling the spring retainer, the Right Plane is selected as the reference plane 

by right-clicking on it, and sketch mode is opened using the Sketch command. 
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3. Defining the Geometric Profile of the Spring Retainer 

In the first phase, using the commands from the Sketch toolbar, the Centerline command 

is used to draw a symmetry axis from the origin along the horizontal. This axis serves as a 

reference element for the alignment and symmetric construction of the profile. The outer contour 

of the spring retainer profile is then drawn, paying close attention to geometric details and 

conformity with the technical specifications. The Smart Dimension command is used to ensure 

dimensional accuracy. 

 
 

4. Generating the Body by Revolution 

After completing the sketch, the Revolve Boss/Base command is accessed from the 

Features toolbar. In the PropertyManager, the Axis of Revolution box is clicked, and the 

symmetry axis around which the rotation is to be performed is then selected. In the Direction 

window, the Blind option is chosen, and the rotation angle is set to 360 degrees. 

In the Selected Contours section, the sketch created in the previous step is selected. The 

software provides an instant preview of the volume to be generated, displayed in a semi-

transparent yellow color. After confirming the settings by clicking the green OK checkmark, the 

3D volume is generated automatically, producing the spring retainer in its final form. This 

process highlights the efficiency and precision of the Revolve command in transforming a 2D 

profile into a three-dimensional model. 
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5. Applying Fillets 

To optimize the geometry and reduce stress concentrations, the Fillet command is used 

from the Features toolbar. After accessing it, the Constant Size Fillet type is selected in the 

PropertyManager, and the desired edge for filleting is chosen in the Items to Fillet box. A value 

of 1 mm is then entered in the Fillet Parameters section. After confirming the settings by clicking 

the OK checkmark, the fillet radius is generated automatically. 

 
 

6. Saving the Model 

To complete the process, the model is saved using the Save button from the menu bar. In 

the save dialog window, the part is named taler, and the storage location is selected according to 

the user's preferences. 
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3.3.7. Modeling the Centering Element 

The centering element ensures precise positioning of the internal components of the fuel 

injector, contributing to its optimal operation by preventing unwanted displacements. 

 

1. Creating a New Part File 

To initiate the three-dimensional modeling process, the main menu bar of the design 

environment is accessed and the New command is selected. In the dialog window that appears, 

the Part category is identified and chosen, representing a base document for modeling individual 

components. This selection is confirmed by clicking the OK checkmark, which automatically 

generates a new working file configured specifically for the parametric design process of the part. 

 

 
 

2.  Creating the Initial Sketch 

To initiate the modeling process, the Right Plane is selected as the working plane by right-

clicking on it, and sketch mode is then activated using the Sketch command from the toolbar. 
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3. Creating and Dimensioning the Profile of the Centering Element 

In the first phase, using the commands from the Sketch toolbar, a horizontal symmetry 

axis is drawn from the origin point using the Centerline command. This axis serves as a reference 

element for the alignment and symmetric construction of the profile. The outer contour of the 

part profile is then drawn according to the figure below. 

 

 

4. Generating the Centering Element by Revolution 

After completing the sketch, the Revolve Boss/Base command is accessed from the 

Features toolbar. In the PropertyManager, the Axis of Revolution box is clicked, and the 

symmetry axis around which the rotation is to be performed is then selected. In the Direction 

window, the Blind option is chosen, and the rotation angle is set to 360 degrees. 

If the generated volume is not automatically previewed in yellow, the sketch created in 

the previous step is manually selected in the Selected Contours section. Following this action, 

the software displays a semi-transparent preview of the volume to be created. After confirming 

the settings by clicking the OK checkmark, the 3D volume is generated automatically, producing 

the centering element in its final form. 
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5. Creating the Bores 

To create the high-pressure bore running through the part, Top Plane is right-clicked and 

the Sketch command is used to initiate a new sketch. 

 
 

In the first phase, the Centerline and Line commands from the Sketch toolbar are used to 

draw a vertical symmetry axis. A segment is then drawn on the upper contour, respecting the 

imposed geometric constraints. The Smart Dimension command is used to apply angular and 

linear constraints, enabling precise definition of distances and angles.. 

 

 
 

To create a circular cross-section channel of 1.5 mm, the Swept Cut command is used from 

the Features toolbar. In the PropertyManager, the Circular Profile option is activated in the 

Profile and Path configuration menu. In the Path Sketch window, sketch no. 2 is selected, which 

contains the lines drawn in the previous step. A value of 1.5 mm is entered for the circular profile 

diameter, and the operation is completed by confirming the settings with the OK checkmark. 
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6. Mirroring the Bore 

To mirror the bore created in the previous step, the Mirror command is used from the 

Features toolbar. After activating the command, the options necessary for correctly configuring 

the mirroring operation are displayed in the PropertyManager. 

The Mirror Face/Plane box is clicked, and the arrow next to the part name is then pressed 

in the working window to open the model's feature tree, where Right Plane is selected. In the 

next step, the Features to Mirror window is accessed, and the Cut-Sweep1 operation is selected 

from the part tree. The software also provides a preview of the mirrored bore if this option is 

active. 

The operation is completed by confirming the settings with the OK checkmark. 
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7. Saving the Model 

To complete the process, the model is saved using the Save button from the menu bar. In 

the save dialog window, the part is named element_de_centrare, and the storage location is 

selected according to the user's preferences. 

 

 

3.3.8. Modeling the Injector Needle 

The injector needle within a fuel injector serves to control the flow rate and precise 

atomization of fuel into the combustion chamber. It moves axially to open and close the injection 

orifices, ensuring optimal fuel atomization. 

 

1. Creating a New Part File 

To initiate the 3D modeling process, the main menu bar is accessed and the New 

command is selected. In the dialog window, the Part category is chosen, and the selection is 

confirmed by clicking the OK checkmark. 

 

 
 

2.  Creating the Initial Sketch 

To initiate the modeling process, the Right Plane is selected as the reference plane by 

right-clicking on it, and sketch mode is then activated using the Sketch command from the 

toolbar. 
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3. Creating and Dimensioning the Profile of the Injector Needle 

In the first phase, using the commands from the Sketch toolbar, a horizontal symmetry 

axis is drawn from the origin point using the Centerline command. This axis serves as a reference 

element for the alignment and symmetric construction of the profile. The outer contour of the 

part profile is then drawn. To ensure dimensional accuracy, exact dimensions are applied and 

distances and angles are verified according to the figure below, using the Smart Dimension 

command. 
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4. Generating the Body by Revolution 

After completing the sketch, the Revolve Boss/Base command is accessed from the 

Features toolbar. In the PropertyManager, the Axis of Revolution box is clicked, and the 

symmetry axis around which the rotation is to be performed is then selected. In the Direction 

window, the Blind option is chosen, and the rotation angle is set to 360 degrees. 

If the generated volume is not automatically previewed in yellow, the sketch created in 

the previous step is manually selected in the Selected Contours section. Following this action, 

the software displays a semi-transparent preview of the volume to be created. After confirming 

the settings by clicking the OK checkmark, the 3D volume is generated automatically, producing 

the injector needle in its final form. 

 

 
 

5. Applying a Chamfer to the Closing Cone of the Spray Orifice 

To apply a chamfer, the Chamfer command is used from the Features toolbar. After 

activating the command, the configuration menu opens in the PropertyManager. In the Chamfer 

Type section, the desired chamfer type is selected, such as Angle-Distance. The edge of the part 

to be chamfered is then chosen in the Items to Chamfer box by selecting it directly from the 

three-dimensional model. The chamfer dimensions are set by entering the corresponding values 

in the Chamfer Parameters section, specifying 1 mm with a 30 degree inclination. After 

previewing the modification, the operation is confirmed by clicking the OK checkmark, and the 

chamfer is automatically generated on the selected edge. 
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6. Saving the Model 

To complete the process, the model is saved using the Save button from the menu bar. In 

the save dialog window, the part is named ac_pulverizator, and the storage location is selected 

according to the user's preferences. 

 

 

3.3.9. Modeling the Nozzle 

The nozzle within a fuel injector ensures fine atomization of fuel for efficient combustion 

in the combustion chamber. It contributes to the uniform distribution of fuel, optimizing engine 

performance and reducing pollutant emissions. 

 

1. Creating a New Part File 
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To initiate the modeling process, the main menu bar is accessed and the New command 

is selected. In the selection window that appears, the Part option is chosen. This selection is 

confirmed by clicking the OK checkmark, thereby generating a new working file configured for 

the parametric design of the part. 

 

 
 

2.  Creating the Initial Sketch 

To initiate the modeling process, the Right Plane is selected as the working plane by right-

clicking on it, and sketch mode is then activated using the Sketch command from the toolbar. 

 

 
 

3. Creating and Dimensioning the Nozzle Sketch 

In the first phase, using the commands from the Sketch toolbar, a horizontal symmetry 

axis is drawn from the origin point using the Centerline command. The outer contour of the part 

profile is then drawn according to the figure below, respecting the dimensioning and element 

sizes using the Smart Dimension command. 
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4. Generating the Body by Revolution 

After completing the sketch, the Revolve Boss/Base command is accessed from the 

Features toolbar. In the PropertyManager, the Axis of Revolution box is clicked, and the 

symmetry axis around which the rotation is to be performed is then selected. In the Direction 

window, the Blind option is chosen, and the rotation angle is set to 360 degrees. 

If the generated volume is not automatically previewed in yellow, the sketch created in 

the previous step is manually selected in the Selected Contours section. Following this action, 

the software displays a semi-transparent preview of the volume to be created. After confirming 

the settings by clicking the OK checkmark, the 3D volume is generated automatically, producing 

the nozzle in its final form. 
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5. Creating the Bores  

To create the high-pressure bore running through the part, Top Plane is right-clicked and 

the Sketch command is used to initiate a new sketch. 

 

 
 

In the first phase, the Centerline and Line commands from the Sketch toolbar are used to 

draw a vertical symmetry axis. A segment is then drawn on the upper contour, respecting the 

geometric constraints imposed according to the figure below. 

 
 

To generate a circular cross-section channel of 1.5 mm, the Cut-Revolve command is used 

from the Features toolbar. In the PropertyManager, the Thin Feature option is activated in the 

configuration menu. In the Axis of Revolution window, Line 2, drawn in the previous step, is 

selected as the axis of rotation. The circular profile dimension is defined by entering a value of 

0.5 mm. After configuring the necessary parameters, the operation is completed by confirming 

the settings with the OK checkmark, thereby generating the desired channel in the part model. 
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6. Circular Pattern of the Bore 

To distribute three bores uniformly around the nozzle body, the Circular Pattern 

command is used from the Features toolbar. 

After activating the command, the Direction 1 box is accessed in the PropertyManager, 

where a circular edge or the central axis of the model is selected as the distribution reference. The 

Equal Spacing option is activated, and a value of 3 is entered in the Number of Instances field, 

ensuring uniform distribution at 120° from one another over a total angle of 360 degrees. 

The Circular Pattern command is accessed from the Features toolbar via the dropdown 

menu of the Linear Pattern command. In the command's PropertyManager, the circular edge of 

the part is selected in the Direction 1 field to define the pattern axis, and the number of instances 

is set to 3 with the Equal Spacing option activated. In the Features and Faces section, the 

corresponding field is clicked and the Cut-Revolve-Thin1 operation is selected from the 

FeatureManager tree, this being the previously created bore that is to be patterned 

circumferentially. 

After verifying the preview and confirming the parameters by clicking the OK checkmark, 

SolidWorks automatically generates the two additional bores, completing the desired 

configuration of the nozzle. 

 

 
 

 

 



Computer-Aided Graphics and Technical Drawing 

110 

 

7. Visualizing the Interior Cross-Section of the Nozzle 

 To examine the interior of the nozzle, the Section View command is used from the 3D 

visualization area. After activating the command, the Planar option is selected in the Section 

Method section of the PropertyManager. Right Plane is chosen in the Section 1 field to section 

the model through the first created bore. After configuring the settings, the section view is 

generated by clicking the OK checkmark. For optimal model alignment, the Ctrl+4 key 

combination is used, which automatically rotates the model to the front view, facilitating detailed 

analysis of the internal geometry. 

 

 
 

8. Saving the Model 

To complete the process, the model is saved using the Save button from the menu bar. In 

the save dialog window, the part is named pulverizator, and the storage location is selected 

according to the user's preferences. 
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3.3.10. Independent Practice Exercises 

The proposed exercises are structured around the specific themes of the chapter, presenting 

for modeling parts with an increased degree of geometric complexity, representative of the fuel 

injection systems domain. Approaching them requires the integrated application of knowledge 

accumulated throughout the entire chapter, as well as the ability to adapt the workflow to the 

constructive particularities of each individual part. Unspecified dimensions are to be determined 

constructively, respecting the geometric proportions of the part. 

 

3.3.10.1. Mounting Bracket 
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3.3.10.2. Modeling the Components of the Hydraulic Chain Tensioner 

The hydraulic tensioner serves to maintain constant tension in the timing chain, 

automatically compensating for the effects of elongation and wear throughout the entire 

operating life of the engine. Its operating principle is based on the displacement of the piston 

against the guide shoe under the action of oil pressure supplied by the engine lubrication system. 

The working chamber is fed through a one-way valve that permits only oil admission, blocking 

its return and thereby preventing piston retraction. The internal spring provides initial chain pre-

tensioning and compensates for rapid tension variations, while oil pressure stabilizes the piston 

position, limiting vibrations and reducing chain wear throughout the service life of the engine. 

The assembly consists of the following components: tensioner body (1) — EN AW-6082, 

spring (2) — 51CrV4, plastic guide (3) — PA6, piston (4) — 34CrMo4, and valve (5) — C45. 
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3.3.11. Assessment Questions 

 

1. Which components exhibit axial symmetry and what advantages does this offer in 

modeling? 

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________ 

____________________________________________________________________________________ 

 

2. What are the modeling steps for a part with a complex profile using the Swept Boss/Base 

command in SolidWorks? 

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________ 

____________________________________________________________________________________ 

 

3. What are the main components of the fuel injector? 

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________ 
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4. CONCLUSIONS AND PERSPECTIVES 

 

This work aims to introduce students to three-dimensional parametric modeling using 

SolidWorks, pursuing the progressive development of the competencies required in computer-

aided design and in understanding the correlation between the geometric model and the 

technical functionality of parts. 

  The first chapter presents the theoretical foundations of computer-aided design, the 

evolution of CAD/CAM/CAE systems, and the general structure of the SolidWorks platform, 

providing the conceptual framework necessary for approaching three-dimensional modeling. 

The second chapter addresses parametric modeling at part level through applications specific to 

mechanical engineering, highlighting the use of fundamental operations and parametric 

relations in defining constructive forms. The third chapter is dedicated to modeling the 

components of a compression-ignition engine fuel injector, covering parts with varying degrees 

of geometric complexity. 

The set of modeled parts serves as the foundation for the study of the Assembly and 

Drawing modules, in which virtual assembly of components, definition of positioning relations, 

and creation of technical engineering drawings are addressed, in accordance with the 

representation rules specific to the field. 

The material will subsequently be expanded through the introduction of dedicated 

applications for the Weldments, Surface Modeling, Sheet Metal, and Simulation modules, as well 

as through deeper work in Assembly and Drawing, based on integrated examples. 
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5. SUBJECTS FOR COMPETENCY ASSESSMENT 

5.1.  Examination Paper No. 1 
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5.2. Examination Paper No. 2 
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5.3. Examination Paper No. 3 
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5.4. Examination Paper No. 4 
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5.5. Examination Paper No. 5 
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